<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Home</td>
<td>2</td>
</tr>
<tr>
<td>1.1 A note to Confluence administrators</td>
<td>2</td>
</tr>
<tr>
<td>1.2 Tutorial</td>
<td>2</td>
</tr>
<tr>
<td>1.2.1 Using the menus</td>
<td>3</td>
</tr>
<tr>
<td>1.2.2 Creating a space</td>
<td>5</td>
</tr>
<tr>
<td>1.2.3 Creating a page</td>
<td>7</td>
</tr>
<tr>
<td>1.2.4 Adding content to a page</td>
<td>9</td>
</tr>
<tr>
<td>1.2.5 Using the Dashboard</td>
<td>14</td>
</tr>
<tr>
<td>1.2.6 Updating your user profile</td>
<td>16</td>
</tr>
<tr>
<td>1.2.7 Adding a comment to a page</td>
<td>18</td>
</tr>
<tr>
<td>1.2.8 Creating a blog post</td>
<td>20</td>
</tr>
<tr>
<td>1.3 Tutorial (all on one page)</td>
<td>22</td>
</tr>
<tr>
<td>1.4 Advanced topics</td>
<td>38</td>
</tr>
<tr>
<td>1.4.1 Creating pages and linking</td>
<td>39</td>
</tr>
<tr>
<td>1.4.2 Formatting content</td>
<td>40</td>
</tr>
<tr>
<td>1.4.3 Searching Confluence content</td>
<td>42</td>
</tr>
<tr>
<td>1.4.4 Creating a task list</td>
<td>43</td>
</tr>
<tr>
<td>1.4.5 Creating a thumbnail gallery</td>
<td>43</td>
</tr>
<tr>
<td>1.4.6 Re-ordering pages</td>
<td>44</td>
</tr>
<tr>
<td>1.4.7 Working with RSS</td>
<td>45</td>
</tr>
<tr>
<td>1.4.8 Integrating with JIRA</td>
<td>46</td>
</tr>
<tr>
<td>1.4.9 Creating an index</td>
<td>47</td>
</tr>
<tr>
<td>1.4.10 Displaying source code</td>
<td>53</td>
</tr>
<tr>
<td>1.4.11 Archiving email</td>
<td>55</td>
</tr>
<tr>
<td>1.5 More information</td>
<td>55</td>
</tr>
<tr>
<td>1.6 Featured Plugins</td>
<td>56</td>
</tr>
<tr>
<td>1.6.1 Plugins for Documentation</td>
<td>57</td>
</tr>
<tr>
<td>1.6.2 Plugins for Intranets</td>
<td>59</td>
</tr>
<tr>
<td>1.6.3 Plugins for Knowledge Management</td>
<td>62</td>
</tr>
<tr>
<td>1.7 Examples</td>
<td>63</td>
</tr>
<tr>
<td>1.7.1 Example Sales Team Page</td>
<td>64</td>
</tr>
<tr>
<td>1.7.1.1 Josh</td>
<td>65</td>
</tr>
<tr>
<td>1.7.1.2 Meeting Notes</td>
<td>68</td>
</tr>
<tr>
<td>1.7.1.2.1 Week 27 Meeting Notes</td>
<td>68</td>
</tr>
<tr>
<td>1.7.1.2.2 Week 28 Meeting Notes</td>
<td>69</td>
</tr>
<tr>
<td>1.7.1.2.3 Week 29 Meeting Notes</td>
<td>69</td>
</tr>
<tr>
<td>1.7.1.3 Sales Reports</td>
<td>70</td>
</tr>
<tr>
<td>1.7.1.4 Sales Tools</td>
<td>72</td>
</tr>
<tr>
<td>1.7.1.5 Team Blog</td>
<td>73</td>
</tr>
<tr>
<td>1.7.2 Example Development Team Page</td>
<td>74</td>
</tr>
<tr>
<td>1.7.2.1 Confluence 3.1 Release Dashboard</td>
<td>76</td>
</tr>
<tr>
<td>1.7.2.2 Confluence Induction</td>
<td>79</td>
</tr>
<tr>
<td>1.7.2.3 Confluence Roadmap</td>
<td>81</td>
</tr>
<tr>
<td>1.7.2.3.1 Community - Hover Profile</td>
<td>82</td>
</tr>
<tr>
<td>1.7.2.3.2 Community - Profile</td>
<td>83</td>
</tr>
<tr>
<td>1.7.2.3.3 Macro Browser Spec</td>
<td>83</td>
</tr>
<tr>
<td>1.7.2.4 Leave Planning</td>
<td>84</td>
</tr>
<tr>
<td>1.7.2.5 Planned Feature Specifications</td>
<td>86</td>
</tr>
<tr>
<td>1.7.2.5.1 Image Browser Spec</td>
<td>86</td>
</tr>
<tr>
<td>1.7.2.5.2 Insert Menu Spec</td>
<td>87</td>
</tr>
<tr>
<td>1.7.2.5.3 Quick Navigation Spec</td>
<td>89</td>
</tr>
<tr>
<td>1.7.3 Example Human Resources Page</td>
<td>90</td>
</tr>
<tr>
<td>1.7.3.1 Company Induction</td>
<td>91</td>
</tr>
<tr>
<td>1.7.3.2 HR Policies and Procedures</td>
<td>92</td>
</tr>
<tr>
<td>1.7.3.3 Recruitment</td>
<td>93</td>
</tr>
<tr>
<td>1.7.3.4 Buddy System</td>
<td>94</td>
</tr>
<tr>
<td>1.7.3.5 Company Birthday List</td>
<td>95</td>
</tr>
<tr>
<td>1.7.3.6 Have Fun</td>
<td>95</td>
</tr>
<tr>
<td>1.7.3.7 How the Talent Team at Atlassian use Confluence</td>
<td>96</td>
</tr>
<tr>
<td>1.7.3.8 Request Leave Form</td>
<td>96</td>
</tr>
<tr>
<td>1.7.4 Example Design Team Page</td>
<td>97</td>
</tr>
<tr>
<td>1.7.4.1 Atlassian Colours</td>
<td>97</td>
</tr>
<tr>
<td>1.7.4.2 Atlassian Cotton</td>
<td>99</td>
</tr>
<tr>
<td>1.7.4.3 Atlassian Logos</td>
<td>100</td>
</tr>
<tr>
<td>1.7.4.4 PowerPoint Templates</td>
<td>101</td>
</tr>
</tbody>
</table>
Welcome to Confluence

The tutorial is designed primarily for evaluators who have recently downloaded and installed Confluence.

If you have already deployed Confluence in your organisation, and are using the tutorial to provide a general introduction for new users on your wiki, please note that the tutorial assumes the following to be true:

- Your Confluence site is using the Default theme.
- The user has the 'Create Space' permission.
- The user has online web access. This is recommended but not essential, because the tutorial includes links to the Confluence online documentation to provide extra information.
Tutorial

This tutorial will help you get started with Confluence:

*Using the menus*

*Creating a space*

*Creating a page*

*Adding content to a page*

*Using the Dashboard*

*Updating your user profile*

*Adding a comment to a page*

*Creating a blog post*

---

**What is a space?**
A space is an area within Confluence, containing your wiki pages. You can think of each space as a sub-site, or mini-site, each with its own home page.

**What is the Dashboard?**
The Dashboard is the home page of your Confluence wiki. The Dashboard contains a list of all the spaces within your wiki, as well as a list of recently updated content.

**What is a wiki?**
A wiki is a piece of software that allows you and your colleagues to create and edit web pages quickly and simply. Just click, edit and save. Content is published immediately.

**What is Confluence?**
Confluence is an enterprise wiki with some extra communication tools, including blog posts and RSS feeds.

**What makes Confluence an enterprise wiki?**
Different organisations use Confluence for different purposes: as a company intranet, corporate website, project workspace, knowledge base, documentation site and a host of other implementations. All these are made possible by Confluence's enterprise-appropriate features, including: security permissions at the page, space and site level; content structuring and restructuring options; LDAP compatibility and more.

✅ If you prefer, you can see the whole tutorial on one page.

---

**Using the menus**

The image below gives an overview of the menus in Confluence. The menus give you access to all the available actions on your Confluence site.
Menu or option | Explanation
---|---
Browse menu | The 'Browse' menu gives access to wiki content such as pages, blog posts, etc, and allows you to browse the People Directory. If you are an administrator, the space and site administration options appear here too.
User menu | After you have logged in, your name will appear at top right of the screen. The 'User' menu appears when your cursor hovers over your name. The menu allows you to log out, access your user profile, editing history, personal labels, page watches and the activities of other users in your network. You can also retrieve drafts of pages you are editing.
Search box | Type into this box and press 'Enter' to search.
Edit button | The 'Edit' button allows you to edit the page.
Add menu | The 'Add' menu allows you to add things to a page or space.
Tools menu | The 'Tools' menu contains miscellaneous actions relating to the page.
Labels | This line shows labels (or tags) attached to the current page.

If your Confluence administrator has customised your Confluence site, then the menus may appear in different positions from those shown here.

If you are not logged in to Confluence, the 'Browse' menu and the 'User' menu will not appear. Instead, a 'Log In' link will appear.
In the tutorial:

- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

## Creating a space

Now that you have seen how the menus work, you are ready to start creating content in Confluence. Let's begin by adding a new space.

1. Log in to Confluence, if you are not logged in already, by clicking the ‘Log In’ link at the top right of your Confluence screen.

2. Right-click the ‘Dashboard’ link at the top left of your screen and open the link in a new browser window.

   ![Dashboard link](image)

   **Hint:** Perform the rest of these instructions in the new browser window.

3. Your Confluence Dashboard appears in the new window. On the left of the screen is a list of spaces. (The Demonstration Space will be one of those spaces.)

4. Click the ‘Create a space’ link, located below the list.

   ![Create a space](image)

5. The ‘Create Space’ screen appears.
6. In the 'Enter a Space Name' box, type a name for your new space. You may want to use your department name (e.g. 'IT', 'Finance' or 'Marketing') or a name that identifies the purpose of the space (e.g. 'Test Space').

   **Enter a space name**

   Test Space

7. In the 'Enter a Space Key' box, type a short abbreviation of the space name (e.g. 'IT' or 'TEST').

   **Enter a space key**

   TEST

8. Under 'Who can use this space', all the boxes are ticked. You don't need to change anything at this time. For information about space permissions, please see the documentation.

   - [x] Me
   - [x] Registered users - anyone logged into Confluence
   - [x] Me
   - [x] Registered users - anyone logged into Confluence

9. Under 'Choose Theme', the 'Default Theme' is selected. Keep the Default Theme for now. For information about themes, please see the documentation.

   **Default Theme**
   Use the globally configured look and feel. You can customise colour schemes and layouts manually.

10. Click the 'OK' button, located at the bottom of the screen.

11. The home page of your new space appears.

   What is a space?
   A space is an area within Confluence, containing your wiki pages. You can think of each space as a sub-site, or mini-site, each with its own home page. You are looking at a space right now, called the Demonstration Space.

   How many spaces should I create?
   That depends on how you are planning to use Confluence. For example, if you are going to use Confluence for your intranet, you may want to create one space per department. If you want to use Confluence to write technical documentation, you could create one space per product.
In the tutorial:
- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

Creating a page

Now you will create a page in your new space.

 Hint: Perform these instructions in the new browser window which you opened previously. (See Creating a space).

1. Under the ‘Add’ menu, select ‘Page’.


3. Click in the box near the top of the screen, where the words ‘New Page’ appear. The words ‘New Page’ will disappear. Type a title for your page (e.g. ‘About this space’).

4. Click in the large ‘Rich Text’ area, below the symbols ‘B I U’. Type a sentence or two (e.g. a description of your space).
5. Press the 'Enter' key twice, to create two new lines.

6. Select 'Heading 2' from the 'Text Styles' box above the 'Rich Text' area, then type 'This is a big heading'.

7. Press the 'Enter' key twice more to create two more new lines.

8. Select 'Heading 5' from the 'Text Styles' box, then type 'This is a small heading'.

 Below the 'Rich Text' area you will find the page's Location, Restrictions and Labels. You don't need to change anything at this time.

9. Click the 'Save' button.

10. You can now see your newly created page.
This tutorial introduces you to the Confluence Rich Text editor, which is similar to text editors you may have used in other software programs. Alternatively, you can choose to use Wiki Markup (a simple content-formatting language, known as Confluence Notation). A quick notation guide, Help Tips, appears at the right of the screen when you choose the 'Wiki Markup' edit tab. You can then click the 'Full notation guide' link to view the full Notation Guide. For more information about Confluence Notation, please see the documentation.

In the tutorial:

- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

Adding content to a page

On this page:

- Opening the page for editing
- Inserting an image
- Inserting a link
- Inserting a table
- Saving your changes

In the previous step, you created a page with some sample content. Now you will edit the page you have created and add some more content.

Opening the page for editing

1. If you are not already viewing the page, go to the page you want to edit.
2. Click the 'Edit' button on the page you want to edit. The button looks like this:

   ![Edit Button](image)

3. Click an empty line in the large 'Rich Text' area, below the symbols 'B / U'.

   ![Rich Text Area](image)
4. Press the ‘Enter’ key twice to create two new lines.

**Inserting an image**

1. Click the **Insert Image** icon on your page.

2. The ‘Insert Image’ window will appear. Ensure that ‘Attached Images’ is selected on the left of the window and click the **Browse** button.

3. A popup window will appear. Select an image file from your computer or your network and click **OK** to upload it to Confluence.

4. Your image appears in the ‘Insert Image’ window. Click the image you have just attached to select it.
5. Click the 'Insert' button.

6. Your selected image now appears on your page.

For more information about working with images, please see the documentation.

**Inserting a link**

1. Press the 'Enter' key twice to create two more new lines.

2. Type the following sentence: 'What is a wiki?'.

3. Select the word 'wiki', then click the 'Insert Link' icon on your page.

4. The 'Insert Link' window will appear.

6. Click the ‘OK’ button.

7. The word ‘wiki’ is now a link.

For more information about working with links, please see the documentation.

**Inserting a table**

1. Press the ‘Enter’ key twice to create two more new lines.

2. Click the ‘Insert Table’ icon on your page.

3. The ‘Insert/Modify Table’ window will appear. Click the ‘OK’ button.
4. A table with two rows and two columns now appears on your page.

5. Click in the column headings or other table cells to add your content to the table.

For more information about working with tables, please see the documentation.

**Saving your changes**

- Click the 'Save' button to save your page.

These instructions assume that you are using the Rich Text Editor.

If you are using Wiki Markup instead, please take a look at the documentation on working with images, working with links and working with tables.
In the tutorial:

- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

**Using the Dashboard**

Now you will use the Dashboard to navigate to the new page and the new space that you created in previous steps of this tutorial.

1. Right-click the 'Dashboard' link at the top left of your screen, and open the link in a new browser window.

   ![Dashboard navigation menu]

   **Hint:** Perform the rest of these instructions in the new browser window.

2. Your Confluence Dashboard appears in the new window.

3. On the right of your Dashboard, under the heading 'Recently Updated', is a list of pages that have recently been added or edited. The page that you previously created will appear in this list (unless many other pages have been added or edited in the meantime).
If your page doesn't appear in the list, skip this step and go to step 6.

4. Click the name of the page that you previously created.

5. Your page appears.

6. Click the 'Dashboard' link at the top left of the screen. Your Confluence Dashboard appears again.

7. On the left of your Dashboard is a list of spaces. Next to each space's name is the 'space' icon.

8. Click the name of the space that you previously created.

9. The home page of your space appears.
The Dashboard is the home page of your Confluence wiki. The Dashboard contains a list of all the spaces within your wiki, as well as a list of recently updated content.

From the Dashboard, you can click any space's name to go to the space's home page.

To get to the Dashboard from anywhere within your wiki, click the ‘Dashboard’ link at the top left of your screen.

### Updating your user profile

Now you will change your Confluence ‘Full Name’ (that is, the name by which you are known to other Confluence users) and profile picture (that is, the picture by which you are known to other Confluence users).

1. Log in to Confluence, if you are not logged in already, by clicking the ‘Log In’ link at the top right of your Confluence screen.

   ![Log In Link](example.com)

2. From the menu under your name, select ‘Profile’.

   ![Profile Menu](example.com)

3. The ‘Profile’ view of your user profile appears.

   ![Profile View](example.com)
4. Click the 'Edit' link within the 'Personal' section on the right-hand-side of this view.

5. In the ‘Full Name’ box, correct the spelling or type an alternative version of your name (e.g. a nickname).

   ![Full Name:](Joseph Webb Bloggs)

6. Click the ‘Save’ button.

7. Your Full Name has now been changed.

   ✔️ Hint: Changing your Full Name does not affect your login name (i.e. username).

8. Still in the 'Profile' view, click 'Picture' at the left of the screen.

   ![Profile Picture](Profile Picture screen)

9. Click the ‘Browse’ button, and select a photo of yourself (e.g. a GIF, JPG or PNG file) from your computer. Then click the ‘Upload’ button.

   ![Upload a Profile Picture](Upload a Profile Picture)

   ✔️ If you don't have a suitable image file, select one of the 'Default Icons' instead. Here are some of them. You will find more on your Profile Picture screen.

10. If the picture you selected is too big, you can now trim it. You will see your picture, with a highlighted box somewhere in the middle. Click and drag the box so that it covers the area of the picture you want. Pull the corners of the box in or out to select a larger or smaller area.
11. Click the ‘Save’ button. Confluence will use the area of the picture which you have selected, and will resize it to the required size (48 pixels by 48 pixels).

12. Your profile picture will appear next to any comments that you add and next to your updates on the Dashboard. Here’s an example:

Your user profile contains your user details (e.g. your name, your picture and your password) and your Confluence user preferences (e.g. time zone and email format). For more information about updating your user profile, please see the documentation.

In the tutorial:

- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

Adding a comment to a page
Now you will add a comment to the page that you previously created. (See Creating a page.)

1. Go to your new page. 
   
   ✔️ For assistance on finding the page, please see Using the Dashboard earlier in the tutorial.

2. Click the 'Add Comment' link at the bottom of the page.

   ![Image of the Add Comment link]

   A 'Rich Text' area appears at the bottom of the page.

3. A ‘Rich Text’ area appears at the bottom of the page.

   ![Image of the Rich Text area]

   4. Type a remark about the page.

   5. Click the 'Post' button.

   6. Your comment now appears at the bottom of the page, together with your name, the profile picture you added previously (see Updating your user profile) and the time your comment was made.
Posting comments in Confluence allows you and your colleagues to hold discussions within your wiki. You can often use the wiki instead of email, for example.

In the tutorial:
- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

Creating a blog post

Now you will create a blog post in your new space.

⚠️ Hint: Perform these instructions in the new browser window which you opened previously. (See Creating a space).

1. Under the 'Add' menu, select 'Blog Post'.

2. A new, blank blog post appears.
3. Click in the box near the top of the screen, where the words 'New Blog Post' appears. The words 'New Blog Post' will disappear. Type a title for your blog post (e.g. 'Latest update').

4. Click in the large 'Rich Text' area, below the symbols 'B / I / U'. Type several sentences.

   There were amazing scenes today.

Below the 'Rich Text' area are the page's Labels and Posting Day (which defaults to today). You don't need to change anything at this time.

5. Click the 'Save' button.

6. You can now see your newly created blog post.
What is a blog post?
Confluence blog posts are special pages found in the 'blog' section of each space. They can be announcements, journal entries, status reports or any other timely information you would categorise as a blog entry or 'news'.

For more information about working with blogs, please see the documentation.

Congratulations, you have finished the Tutorial! Next, you may like to see some examples of wiki pages, read some of the advanced topics or take a look at our other documentation.

In the tutorial:
- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

Tutorial (all on one page)
Welcome to the tutorial on a page! This page contains all the topics from the tutorial.

On this page:
- Using the menus
- Creating a space
- Creating a page
- Adding content to a page
  - Opening the page for editing
  - Inserting an image
  - Inserting a link
  - Inserting a table
  - Saving your changes
- Using the Dashboard
- Updating your user profile
- Adding a comment to a page
- Creating a blog post

Using the menus
The image below gives an overview of the menus in Confluence. The menus give you access to all the available actions on your Confluence site.
Creating a space

Now that you have seen how the menus work, you are ready to start creating content in Confluence. Let's begin by adding a new space.
1. Log in to Confluence, if you are not logged in already, by clicking the ‘Log In’ link at the top right of your Confluence screen.

2. Right-click the ‘Dashboard’ link at the top left of your screen and open the link in a new browser window.

Hint: Perform the rest of these instructions in the new browser window.

3. Your Confluence Dashboard appears in the new window. On the left of the screen is a list of spaces. (The Demonstration Space will be one of those spaces.)

4. Click the ‘Create a space’ link, located below the list.

5. The ‘Create Space’ screen appears.
6. In the 'Enter a Space Name' box, type a name for your new space. You may want to use your department name (e.g. 'IT', 'Finance' or 'Marketing') or a name that identifies the purpose of the space (e.g. 'Test Space').

   ![Enter a space name]
   - Test Space

7. In the 'Enter a Space Key' box, type a short abbreviation of the space name (e.g. 'IT' or 'TEST').

   ![Enter a space key]
   - TEST

8. Under 'Who can use this space', all the boxes are ticked. You don't need to change anything at this time. For information about space permissions, please see the documentation.

   ![Choose who can view and comment on content]
   - Mo
   - Registered users - anyone logged into Confluence

   ![Choose who can contribute (create and edit) content]
   - Mo
   - Registered users - anyone logged into Confluence

9. Under 'Choose Theme', the 'Default Theme' is selected. Keep the Default Theme for now. For information about themes, please see the documentation.

   ![Default Theme]
   - Use the globally configured look and feel. You can customise colour schemes and layouts manually.

10. Click the 'OK' button, located at the bottom of the screen.

11. The home page of your new space appears.

![What is a space?]
A space is an area within Confluence, containing your wiki pages. You can think of each space as a sub-site, or mini-site, each with its own home page. You are looking at a space right now, called the Demonstration Space.

**How many spaces should I create?**
That depends on how you are planning to use Confluence. For example, if you are going to use Confluence for your intranet, you may want to create one space per department. If you want to use Confluence to write technical documentation, you could create one space per product.

---

**Creating a page**

Now you will create a page in your new space.

- **Hint**: Perform these instructions in the new browser window which you opened previously. (See Creating a space).

1. Under the 'Add' menu, select 'Page'.

   ![Add Page]

3. Click in the box near the top of the screen, where the words 'New Page' appear. The words 'New Page' will disappear. Type a title for your page (e.g. 'About this space').

**About this space**

4. Click in the large 'Rich Text' area, below the symbols 'B / U'. Type a sentence or two (e.g. a description of your space).

```
This is a description of my space.
```

5. Press the 'Enter' key twice, to create two new lines.

6. Select 'Heading 2' from the 'Text Styles' box above the 'Rich Text' area, then type 'This is a big heading'.
7. Press the 'Enter' key twice more to create two more new lines.

8. Select 'Heading 5' from the 'Text Styles' box, then type 'This is a small heading'.

Below the 'Rich Text' area you will find the page's Location, Restrictions and Labels. You don't need to change anything at this time.

9. Click the 'Save' button.

10. You can now see your newly created page.

About this space

Added by Sarah Maddox, last edited by Sarah Maddox on Jul 23, 2008

This is a description of my space.

This is a big heading

This is a small heading

Add Labels

Add Comment

This tutorial introduces you to the Confluence Rich Text editor, which is similar to text editors you may have used in other software programs. Alternatively, you can choose to use Wiki Markup (a simple content-formatting language, known as Confluence Notation). A quick notation guide, Help Tips, appears at the right of the screen when you choose the 'Wiki Markup' edit tab. You can then click the 'Full notation guide' link to view the full Notation Guide. For more information about Confluence Notation, please see the documentation.
Adding content to a page

In the previous step, you created a page with some sample content. Now you will edit the page you have created and add some more content.

Opening the page for editing

1. If you are not already viewing the page, go to the page you want to edit.

2. Click the 'Edit' button on the page you want to edit. The button looks like this:

   ![Edit button]

3. Click an empty line in the large 'Rich Text' area, below the symbols 'B / U'.

   ![Rich Text editor]

4. Press the 'Enter' key twice to create two new lines.

Inserting an image

1. Click the 'Insert Image' icon on your page.

   ![Insert Image icon]

2. The 'Insert Image' window will appear. Ensure that 'Attached Images' is selected on the left of the window and click the 'Browse' button.

   ![Insert Image window]

3. A popup window will appear. Select an image file from your computer or your network and click 'OK' to upload it to Confluence.

4. Your image appears in the 'Insert Image' window. Click the image you have just attached to select it.
5. Click the 'Insert' button.

6. Your selected image now appears on your page.

For more information about working with images, please see the documentation.

**Inserting a link**

1. Press the 'Enter' key twice to create two more new lines.

2. Type the following sentence: 'What is a wiki?'.

3. Select the word 'wiki', then click the 'Insert Link' icon on your page.

4. The 'Insert Link' window will appear.
5. In the 'Link' box, type "http://www.atlassian.com/software/confluence/wiki.jsp".

6. Click the 'OK' button.

7. The word 'wiki' is now a link.

For more information about working with links, please see the documentation.

**Inserting a table**

1. Press the 'Enter' key twice to create two more new lines.

2. Click the 'Insert Table' icon on your page.

3. The 'Insert/Modify Table' window will appear. Click the 'OK' button.
4. A table with two rows and two columns now appears on your page.

5. Click in the column headings or other table cells to add your content to the table.

For more information about working with tables, please see the documentation.

**Saving your changes**

- Click the ‘Save’ button to save your page.

These instructions assume that you are using the Rich Text Editor.

If you are using Wiki Markup instead, please take a look at the documentation on working with images, working with links and working with tables.

**Using the Dashboard**
Now you will use the Dashboard to navigate to the new page and the new space that you created in previous steps of this tutorial.

1. Right-click the ‘Dashboard’ link at the top left of your screen, and open the link in a new browser window.

(Insert image here)

Hint: Perform the rest of these instructions in the new browser window.

2. Your Confluence Dashboard appears in the new window.

3. On the right of your Dashboard, under the heading ‘Recently Updated’, is a list of pages that have recently been added or edited. The page that you previously created will appear in this list (unless many other pages have been added or edited in the meantime).

(Insert table here)

4. If your page doesn't appear in the list, skip this step and go to step 6.

5. Click the name of the page that you previously created.

6. Your page appears.

7. Click the ‘Dashboard’ link at the top left of the screen. Your Confluence Dashboard appears again.

8. On the left of your Dashboard is a list of spaces. Next to each space’s name is the ‘space’ icon.
8. Click the name of the space that you previously created.

9. The home page of your space appears.

The Dashboard is the home page of your Confluence wiki. The Dashboard contains a list of all the spaces within your wiki, as well as a list of recently updated content.

From the Dashboard, you can click any space’s name to go to the space's home page.

To get to the Dashboard from anywhere within your wiki, click the 'Dashboard' link at the top left of your screen.

Updating your user profile

Now you will change your Confluence ‘Full Name’ (that is, the name by which you are known to other Confluence users) and profile picture (that is, the picture by which you are known to other Confluence users).

1. Log in to Confluence, if you are not logged in already, by clicking the ‘Log In’ link at the top right of your Confluence screen.

2. From the menu under your name, select ‘Profile’.

3. The ‘Profile’ view of your user profile appears.
4. Click the 'Edit' link within the 'Personal' section on the right-hand-side of this view.

5. In the 'Full Name' box, correct the spelling or type an alternative version of your name (e.g. a nickname).

   Full Name: Joseph Webb Bloggs

6. Click the 'Save' button.

7. Your Full Name has now been changed.

   Hint: Changing your Full Name does not affect your login name (i.e. username).

8. Still in the 'Profile' view, click 'Picture' at the left of the screen.

9. Click the 'Browse' button, and select a photo of yourself (e.g. a GIF, JPG or PNG file) from your computer. Then click the 'Upload' button.

   Upload a Profile Picture: Upload your own profile picture. Profile pictures will be automatically resized to 48 x 48 pixels.

   ![Profile Picture]

   If you don't have a suitable image file, select one of the 'Default Icons' instead. Here are some of them. You will find more on your Profile Picture screen.
10. If the picture you selected is too big, you can now trim it. You will see your picture, with a highlighted box somewhere in the middle. Click and drag the box so that it covers the area of the picture you want. Pull the corners of the box in or out to select a larger or smaller area.

Select the area you want to use as your profile picture.

11. Click the 'Save' button. Confluence will use the area of the picture which you have selected, and will resize it to the required size (48 pixels by 48 pixels).

12. Your profile picture will appear next to any comments that you add and next to your updates on the Dashboard. Here’s an example:

<table>
<thead>
<tr>
<th>David Chui</th>
<th>How to make a custom field “importable” for project imports</th>
</tr>
</thead>
<tbody>
<tr>
<td>about 2 hours ago</td>
<td>Updated list of plugins which support the project import interface and replaced reference to JIRA 4.0 with reference to ...</td>
</tr>
</tbody>
</table>
Your user profile contains your user details (e.g. your name, your picture and your password) and your Confluence user preferences (e.g. time zone and email format). For more information about updating your user profile, please see the documentation.

Adding a comment to a page

Now you will add a comment to the page that you previously created. (See Creating a page.)

1. Go to your new page.
   - For assistance on finding the page, please see Using the Dashboard earlier in the tutorial.

2. Click the 'Add Comment' link at the bottom of the page.

3. A 'Rich Text' area appears at the bottom of the page.

4. Type a remark about the page.

5. Click the 'Post' button.
6. Your comment now appears at the bottom of the page, together with your name, the profile picture you added previously (see Updating your user profile) and the time your comment was made.

Posting comments in Confluence allows you and your colleagues to hold discussions within your wiki. You can often use the wiki instead of email, for example.

Creating a blog post

Now you will create a blog post in your new space.

Hint: Perform these instructions in the new browser window which you opened previously. (See Creating a space).

1. Under the 'Add' menu, select 'Blog Post'.

2. A new, blank blog post appears.

3. Click in the box near the top of the screen, where the words 'New Blog Post' appears. The words 'New Blog Post' will disappear. Type a title for your blog post (e.g. 'Latest update').
4. Click in the large ‘Rich Text’ area, below the symbols ‘B / I’. Type several sentences.

There were amazing scenes today.

Below the ‘Rich Text’ area are the page’s Labels and Posting Day (which defaults to today). You don’t need to change anything at this time.

5. Click the ‘Save’ button.

6. You can now see your newly created blog post.

**What is a blog post?**
Confluence blog posts are special pages found in the ‘blog’ section of each space. They can be announcements, journal entries, status reports or any other timely information you would categorise as a blog entry or ‘news’.

For more information about working with blogs, please see the [documentation](#).

**Advanced topics**

If you have used Confluence before, you may be interested in the following advanced topics:

- Creating pages and linking
- Formatting content
- Searching Confluence content
- Creating a task list
- Creating a thumbnail gallery
Creating pages and linking

A very useful aspect of Confluence is rapid page creation based on linking.

Creating new pages through links

There are two ways to create a new page:

- The first is to hit 'Add Page' in the menu. You will find detailed instructions in the tutorial in this space.
- The second is to simply link to a new page in an existing one. Just click the 'Edit' link and, using Wiki Markup, type in the following:

  ![my_new_page]

  It will produce this: my new page.

The red, underlined text indicates that if you click on it you will be given the option of creating a new page.

You can read more about Wiki Markup in the documentation.

Pages have parents, just like anyone

Pages themselves can have parents, and thus you can create 'page families' (or page hierarchies) in Confluence. These are useful for showing logical connections between pages, as we have done for the 'Home' page and every other page in the Demonstration Space:

- A note to Confluence administrators
- Tutorial
  - Using the menus
  - Creating a space
  - Creating a page
  - Adding content to a page
  - Using the Dashboard
  - Updating your user profile
  - Adding a comment to a page
  - Creating a blog post
- Tutorial (all on one page)
- Advanced topics
  - Creating pages and linking
  - Formatting content
  - Searching Confluence content
  - Creating a task list
  - Creating a thumbnail gallery
  - Re-ordering pages
  - Working with RSS
  - Integrating with JIRA
  - Creating an index
It's up to you what kind of meaning you want your page hierarchies to represent. A common use is similar to a table of contents in a book, which presents a chapter with pages belonging to it.

Wikis differ to the classical notion of books, however, and it is appropriate to think in a wider context and experiment with how content can be presented in a useful way for a community of users.

The documentation on the left is an abbreviated version of the online documentation for creating pages and links.

You may also find the documentation on page families useful.

Formatting content

Confluence pages are written in a simple markup language based on Textile. By using this simple markup, Confluence makes it easy for your team to create and share content together.

Here is a short example of some typical markup:

Confluence Markup

Titles can be easily built using
Text can be *emphasised*, **bolded**, cited, deleted, inserted, used as ^superscript^ or as _subscript_, used as %a span%, given in bq. blockquotes.

| 1. Text can be _emphasised_, "bolded", ??cited??, -deleted-, +inserted+, used as ^superscript^ or as _subscript_, [{monospaced}]], used as %a span%, given in bq. blockquotes. |

**Colour**

You can specify a colour simply by typing the name of the colour into the 'color' macro: blue, orange, green, red, purple, etc.

| 1. You can specify a colour simply by typing the name of the colour into the 'color' macro: (color:blue)blue(color), (color:orange)orange(color), |
| 2. (color:green)green{color}, (color:red)red{color}, (color:purple)purple{color}, etc. |
| 3. |
| 4. or you can specify a RGB value in hexadecimal. |

**Lists**

Lists can be bulleted or ordered by number:

- Kinds of Markup
  - Text Effects
  - Headings
  - Text Breaks
  - Links
  - Other

- Kinds of Markup
  1. Text Effects
  2. Headings
  3. Text Breaks
  4. Links
  5. Other

| 1. **Kinds of Markup** |
| 2. **Text Effects** |
| 3. **Headings** |
| 4. **Text Breaks** |
| 5. **Links** |
| 6. **Other** |

**Tables**

Use the pipe character to build tables quickly:

<table>
<thead>
<tr>
<th>Name</th>
<th>Office</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alice</td>
<td>01</td>
</tr>
<tr>
<td>Bob</td>
<td>23</td>
</tr>
<tr>
<td>Cathy</td>
<td>45</td>
</tr>
</tbody>
</table>

| 1. | Name | Office |
| 2. | Alice | 01 |
| 3. | Bob | 23 |
| 4. | Cathy | 45 |
Confluence Markup is easy to learn and quick to use. At left you will find a quick overview of markup, but not a comprehensive one. It is enough to get you started. For further details, please visit the online documentation for Confluence Markup.

For those who prefer it, Confluence also provides a WYSIWYG editor.

When editing in Wiki Markup mode, look at the full notational guide on the lower right-hand side of the page for quick tips on how to insert headings, lists, tables, and so on.

---

Searching Confluence content

Confluence can search content including pages, blog posts, emails, Microsoft Word documents and Excel spreadsheets, PDF documents, and more.

As well as using the search box at the top right of every Confluence page for ad hoc searches, you can use the ‘Search’ macro to embed particular search results in a particular page.

E.g. you could use the following code to find content that contains the word ‘tutorial’:

```
1.(search:tutorial)
```

... giving this:

**Found 10 search result(s) for tutorial.**

- Tutorials (Support)
  * Tutorials
    * Feb 26, 2007
- Tutorial (Demonstration Space)
  * Tutorial (Demonstration Space)
  * Options; LDAP compatibility and more. (/) If you prefer, you can see the whole tutorial on one page Tutorial (all on one page). Changed instance of 'news items' to 'blog posts' Tutorial
  * This
  * Nov 20, 2009
- Confluence Tutorial Videos (Marketing)
  * Confluence Tutorial Videos
  * Oct 06, 2009
- Plugin developer tutorials (Technical Writing)
  * Plugin developer tutorials (Technical Writing)
  * ... discussion with Don Brown Wed 14/7 General notes Cookbook concept is good, for tutorials too. Not necessarily a separate tutorial for each module type. Maybe for some of them, e.g. the REST module which ... ...
  * Aug 12, 2009
- Confluence Hosted Tutorial (Hosted Services)
  * Confluence Hosted Tutorial (Hosted Services)
  * Confluence Hosted Tutorial Goal Create a onepage overview tutorial of Confluence Hosted which gives the customer everything they need to being rudimentary use ... links to where you can find more information on any given topic. The ...
  * Oct 29, 2007
- Application Plugin Tutorial (Crowd)
  * Application Plugin Tutorial (Crowd)
  * Application Plugin Tutorial incomplete. in progress. In this tutorial, we will create an application plugin to protect a simple servlet. 1. Write ...
  * Sep 03, 2008
- Tutorial wish list for Doc Sprint (Technical Writing)
  * Tutorial wish list for Doc Sprint (Technical Writing)
  * ... sprinters and anyone else at any time. We'd love your requests for new tutorials and your comments on the suggestions already made. On this page: Existing tutorials These pages contain links to our most recentlydeveloped tutorials. These are the tutorials that already use the new SDK ...
  * Mar 06, 2010
- New Confluence Tutorial Videos for 3.1 (Marketing)
  * New Confluence Tutorial Videos for 3.1 (Marketing)
  * 1 Adding a Page Tutorial 2 Inserting Images Tutorial 3 Inserting links Tutorial 4 Using Macros Tutorial 4 Using Macros Tutorial 5 Adding Columns and Sections Tutorial 6 Adding Attachments Tutorial 7 Searching Tutorial
  * Dec 28, 2009
- Bulletproof testing for plugin tutorial code (Edwin Dawson)
  * Bulletproof testing for plugin tutorial code (Edwin Dawson)
  * ... work (developers and technical writers) on commercial products will suffer. Gritty details Each tutorial we add will have unit tests and functional tests if necessary. The tutorial code will be checked into (public) Subversion. The real code will be referenced from the Subversion repository ...
  * Feb 18, 2010
- InfoQ Recommended TDD Tutorials (Peter de Zwart)
  * InfoQ Recommended TDD Tutorials
The Confluence search engine is based on Lucene. It begins working as soon as you install Confluence and can build search indices on a wide range of document types: blogs, pages, comments, attachments, etc.

For more information about performing a search on your Confluence content, please see the documentation.

Creating a task list

The 'tasklist' macro allows you to create lists of tasks which need to be performed and keep track of who has completed them.

<table>
<thead>
<tr>
<th>Things to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Mary to preview her presentation with the team</td>
</tr>
<tr>
<td>□ Tony to call meeting with investors</td>
</tr>
<tr>
<td>□ Tony to book catering</td>
</tr>
<tr>
<td>□ Mary to finalise presentation with Steve</td>
</tr>
<tr>
<td>□ Everyone relax before presentation</td>
</tr>
</tbody>
</table>

The data for the task list is stored in the Confluence page. Most people will find it easier to add or modify tasks while viewing the page. But if you want to edit or even create the task list directly, you can do so by editing the page itself. Here is an example, showing the Wiki Markup for the above task list:

```
{tasklist:Things to do}
Mary to preview her presentation with the team
Tony to call meeting with investors
Tony to book catering
Mary to finalise presentation with Steve
Everyone relax before presentation
{tasklist}
```

For more information about the 'tasklist' macro, please see the documentation.

Creating a thumbnail gallery

Images look very effective when included within Confluence. Confluence allows you to easily display images as thumbnails, i.e. miniature images.

Including single images and displaying them as thumbnails

When you insert an image onto a page, you can choose to display it as a thumbnail.

Once the image has been inserted, here is what the Wiki Markup looks like:

```
!wikipatterns.png|thumbnail!
```

... and here is what the thumbnail image looks like:
Using the 'gallery' macro

The Confluence 'gallery' macro allows you to display a gallery of thumbnails. It is very simple to use and automatically presents all images attached to a page, in a tabular format. For example, this code:

```
1. {gallery:title=Atlassian T-shirts}
2. {gallery}
```

gives this:

**Atlassian T-shirts**

![Atlassian T-shirts gallery](image)

Try clicking one of the images above. It will open a slide show where you can browse through the pictures.

You can read more about the 'gallery' macro in the documentation.

Re-ordering pages

The following instructions will show you how to view the hierarchy of pages within a space, and move pages to different positions within the hierarchy.

It is suggested that you use the new space that you created during the Tutorial (see 'Creating a space').

PART A: First, you will create some new pages:

1. Go to the home page of your new space.
2. Under the 'Add' menu, select 'Page'.
3. A new, blank page appears.
4. Click in the box near the top of the screen, where the words 'New Page' appear. The words 'New Page' will disappear. Type the following title: 'Book One'.
5. Save your new page and go back to the space's home page.
6. Repeat steps 2-5, but give your new page the title 'Chapter One'.
7. Repeat steps 2-5, but give your new page the title 'Chapter Two'.

You have now created three new pages. All three pages are children of the space's home page.
PART B: Now you will view the pages within your space, and move some of your new pages into more logical positions:

1. From the 'Browse' menu, select 'Pages'.
2. A list of pages appears.
3. Click the plus-sign next to the word 'Home'.
4. A list of pages (i.e. children of the space's home page) is displayed. Your three new pages are included in the list, i.e.
   - 'Book One'
   - 'Chapter One'
   - 'Chapter Two'
5. With your mouse, drag 'Chapter One' onto 'Book One'.
6. Click the plus-sign next to the word 'Home'.
7. A plus-sign now appears next to the words 'Book One'. Click this plus-sign.
8. 'Chapter One' now appears indented below 'Book One'. Your tree should now look like this:
   - 'Book One'
     - 'Chapter One'
     - 'Chapter Two'
9. With your mouse, drag 'Chapter Two' onto 'Book One'.
10. Click the plus-sign next to the word 'Home'.
11. Click the plus-sign next to the words 'Chapter One'. Your tree should now look like this:
    - 'Book One'
      - 'Chapter One'
      - 'Chapter Two'

In Confluence, you can organise pages into a hierarchy of parent and child pages. Pages in such a hierarchy are called a 'page family' (or 'page tree'). For more information about working with page families, please see the documentation. By default, a new page is the child of the page you were viewing when you started creating the new page.

There are three ways to view the list of pages in a space. You can choose to view:

- recently-added pages only
- all pages, in alphabetic order
- all pages, in hierarchical order (also known as a 'page tree')

If the list of pages contains just the word 'Home' with a plus-sign next to it, then you are looking at the hierarchical order. If not, click 'Tree' (next to the word 'View', above the list of pages).

---

**Working with RSS**

RSS is generally used to notify others of the latest news and updates to a site. Confluence reads incoming RSS and creates outgoing RSS. It allows you to stay informed of the latest current affairs of others and allows you to tell them of your own.

**Displaying RSS from other sites**

If another site publishes an RSS feed, you can include its contents in a Confluence page by including the 'RSS' macro in the page.

E.g. Here is the macro code for displaying an RSS feed published by the BBC:

```markdown
1.[rss: url=|max=5]
```

The above code gives the following output:

---

**BBC News**

**World** | **UK Edition**

( Get the latest BBC World News: international news, features and analysis from Africa, Americas, South Asia, Asia-Pacific, Europe and the Middle East.)

---

- **Obama hails forces on Afghan trip**
  US President Barack Obama tells US forces in Afghanistan they are there to help Afghans to forge a "hard-won peace".

- **UN call for new DR Congo strategy**
  The head of the UN mission in DR Congo says new measures are needed to stop massacres by the Lord's Resistance Army.

- **Farc releases Colombian soldier**
  Colombia's main leftist rebels, the Farc, frees a soldier it seized just under a year ago, with hopes of another release to come.

- **Flood traps Chinese coal miners**
  Rescuers try to reach more than 150 coal miners trapped after a pit flooded in northern China, state media reports.

- **Gunmen hold up 'Swiss Las Vegas'**
Masked gunmen storm a packed Swiss casino, escaping into France with a large sum of money, prosecutors say.

Did the above feed display an error message? Your Confluence administrator needs to enable the RSS feed macro, and to add the BBC to the whitelist of allowed URLs.

### Subscribing to Confluence updates via RSS

Confluence also produces RSS that you can subscribe to (using an RSS Newsreader) in order to receive notifications of new or updated content on your Confluence site.

Confluence automatically generates RSS feeds for:

- New blog posts
- New pages
- Updated pages
- New comments on pages and/or blog posts

There are two easy ways to subscribe to Confluence's RSS feeds:

1. Confluence provides a number of pre-defined RSS feeds for each space. You can find these by selecting 'Browse', 'Advanced', 'RSS'.
2. An RSS Feed Builder is also available, should you wish to create a custom feed. Please see the documentation for details.

In Confluence, you can both display and subscribe to RSS feeds.

#### Displaying RSS Feeds

By embedding outside RSS feeds into your Confluence pages, you can automatically display the latest news from sources outside Confluence.

#### Subscribing to RSS Feeds

By subscribing to RSS feeds generated by Confluence, you can stay automatically informed of changes and updates going on within your Confluence site.

At left is a quick introduction to the use of RSS in Confluence. For more information please visit the documentation.

### Integrating with JIRA

JIRA is Atlassian's issue tracking system. Confluence and JIRA can be used together, allowing the integration of a content management solution with an issue tracker. For example, the JIRA Issues macro can be used to display a list of JIRA issues on your Confluence page:

<table>
<thead>
<tr>
<th>JIRA Issues (25 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
</tbody>
</table>
Creating an index

This page shows an example of the 'index' macro.

Macro code

The next section on this page, under the heading 'Macro result', contains the following macro code:

1. \{index\}

Macro result

Space Index

<table>
<thead>
<tr>
<th>0-9 ... 0</th>
<th>A ... 8</th>
<th>B ... 1</th>
<th>C ... 14</th>
<th>D ... 1</th>
<th>E ... 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>F ... 2</td>
<td>G ... 0</td>
<td>H ... 4</td>
<td>I ... 3</td>
<td>J ... 1</td>
<td>K ... 0</td>
</tr>
<tr>
<td>L ... 1</td>
<td>M ... 3</td>
<td>N ... 0</td>
<td>O ... 0</td>
<td>P ... 5</td>
<td>Q ... 1</td>
</tr>
<tr>
<td>R ... 3</td>
<td>S ... 3</td>
<td>T ... 3</td>
<td>U ... 3</td>
<td>V ... 0</td>
<td>W ... 4</td>
</tr>
<tr>
<td>X ... 0</td>
<td>Y ... 0</td>
<td>Z ... 0</td>
<td>@#$ ... 0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

0-9

A note to Confluence administrators

tutorial Tutorial is designed primarily for evaluators who have recently downloaded and installed Confluence. If you have already deployed Confluence in your organisation, and are using the tutorial to provide a general introduction for new users on your wiki, please note that the tutorial ...

Adding a comment to a page

Now you will add a comment to the page that you previously created. (See Creating a
Adding content to a page  
page: In the previous step Creating a page, you created a page with some sample content. Now you will edit the page you have created and add some more content. Opening the page for editing # If you are not already viewing the page, go ...

Advanced topics  
you have used Confluence before, you may be interested in the following advanced topics:

Archiving email  
Confluence can archive emails which is useful for tracking information over a long period of time, and for permanently referencing emails from within documents. Email archiving allows you to: Keep a history of interaction with your clients, colleagues or friends. Refer ...

Atlassian Colours  
Atlassian Cotton If you have a company standard colour scheme that should be used in all of your public-facing resources, record them on the wiki so that others can find them ...

Atlassian Cotton  
Atlassian Colours Atlassian Logos Confluence is a great tool for sharing images with your staff, customers or anyone on the internet. Below is a gallery of all the Atlassian Shirts that the Design Team have created. You could use ...

Atlassian Logos  
Atlassian Cotton Atlassian Logos Confluence is a great tool for sharing images with your staff, customers or anyone on the internet. Below is a gallery of all the Atlassian Shirts that the Design Team have created. You could use ...

Atlassian Logos  
Atlassian Cotton Atlassian Logos PowerPoint Templates Rather than being hassled by employees looking for Atlassian's product logos, the Design Team have made them available by attaching them to a Confluence page. Users are able to preview ...

Buddy System  
Buddy System Imagesbtnprevious.png! Recruitment !Imagesbtnnext.png align=right! Company Birthday List Use the rich text editor to author and format documents like this overview of the Buddy System. Once the document is complete and ready to publish, simply export the document to PDF for presentation as an ...

C  
Community - Hover Profile Imagesbtnprevious.png! Confluence Roadmap Goal Show quickly and conveniently key details about a Confluence user wherever that user's name appears. Mockup !0.02.1.png thumbnail! Use Cases # Sees popup with details about the user as per the mockup # More menu ...

Community - Profile Imagesbtnprevious.png! Confluence Roadmap Goal Give users richer profiles that contained 'structured' data that can be used by Confluence. Mockup !0.01.6.png thumbnail! Use Cases # User can specify profile details about themselves. # Admins can edit users ...

Company Birthday List Imagesbtnprevious.png! Buddy List !Imagesbtnnext.png align=right! Have Fun The table below is actually an Excel Spreadsheet that has been embedded in the page using the Office Connector http://confluence.atlassian.com/display/DOC/DisplayinganOfficeDocumentinConfluence. You can also embed ...

Company Induction Imagesbtnprevious.png! Example Human Resources Page !Imagesbtnnext.png align=right! HR Policies and Procedures The Human Resources team uses tasklists Creating a task list to assign and prioritise simple tasks for new employees. Add a new task to this list Change ...

Confluence 3.1 Release Dashboard Imagesbtnprevious.png! Confluence Roadmap !Imagesbtnnext.png align=right! Planned Feature Specifications The Confluence Development Team always knows its status relative to plan. At the end of each week, the team updates the issues table below to show which issues were ...

Confluence Induction Imagesbtnprevious.png! Leave Planning !Imagesbtnnext.png align=right! Examples Confluence can help development teams get new members up to speed quickly so that they’re fixing bugs sooner and detracting less from highly productive members ...

Confluence Roadmap Imagesbtnprevious.png! Example Development Team Page !Imagesbtnnext.png align=right! Confluence 3.1 Release Dashboard Confluence 3.1 (Q4 2009) Headline Themes and Features Integration with Gadgets Cross Product Integration: Display confluence content inside JIRA dashboard ...

Creating a blog post
Now you will create a blog post in your new space. Hint: Perform these instructions in the new browser window which you opened previously. (See Creating a space). # Under the 'Add' menu, select 'Blog Post'.

Creating a page
Now you will create a page in your new space. Hint: Perform these instructions in the new browser window which you opened previously. (See Creating a space). # Under the 'Add' menu, select 'Page'.

Creating a space
Now that you have seen how the menus work, you are ready to start creating content in Confluence. Let's begin by adding a new space. # Log in to Confluence, if you are not logged in already, by clicking the 'Log In' link at the top right ...

Creating a task list
tasklist' macro allows you to create lists of tasks which need to be performed and keep track of who has completed them. Mary to preview her presentation with the team Tony to call meeting with investors Tony to book catering Mary to finalise ...

Creating a thumbnail gallery
Images look very effective when included within Confluence. Confluence allows you to easily display images as thumbnails, i.e. miniature images. Including single images and displaying them as thumbnails When you insert an image onto ...

Creating an index
Page shows an example of the 'index' macro. Macro code The next section on this page, under the heading 'Macro result', contains the following macro code: Macro result The example at left shows how to create an index based on page ...

Creating pages and linking
very useful aspect of Confluence is rapid page creation based on linking. Creating new pages through links There are two ways to create a new page: The first is to hit 'Add Page' in the menu. You will find detailed instructions in the tutorial Creating ...

Example Design Team Page
Imagesbtnprevious.png! Examples! Imagesbtnnext.png align=right! Atlassian Colours
Click on the {}Next{} and {}Previous{} buttons on the right and left of each page to navigate throughout this example. !DesignHome.png width=603,height=403! Welcome The Design Team space is a repository for visual aspects of the Atlassian ...

Example Development Team Page
Imagesbtnprevious.png! Examples! Imagesbtnnext.png align=right! Confluence Roadmap
The Confluence Development Team at Atlassian uses Confluence to induct new members, collaborate on feature specifications and hit key milestones on time. Click into each of the links in the yellow box below to see ...

Example Human Resources Page
Imagesbtnprevious.png! Examples! Imagesbtnnext.png align=right! Company Induction
Your Human Resources team can use Confluence for presenting important HRelated documents and processes. Click through the slideshow below to see how the HR team presents the company mission ...

Example Sales Team Page
Imagesbtnprevious.png! Examples! Imagesbtnnext.png align=right! Meeting Notes
Teams can use Confluence to collaborate internally and share information with the rest of the organization. Here's an example of how a sales team uses Confluence. Click into each one of the Quick Links ...

Examples
real world examples of how Confluence can be used in your organisation. As you go through these examples, look at the underlying markup to see how the pages were created. (See the markup by selecting View Wiki Markup from the Tools menu ...)
Formatting content

Confluence pages are written in a simple markup language based on Textile
http://textism.com/tools/textile/. By using this simple markup, Confluence makes it easy for your team to create and share content together. Here is a short example of some typical markup ...

Have Fun
Imagesbtnprevious.png! Company Birthday List !Imagesbtnnext.png align=right!

Confluence lets you easily embed content from popular user-generated sites like YouTube, Flickr, Slideshare, Google, Twitter and many ...

Home
Welcome to Confluence
!Imagesimgwelcome.png width=590,height=279!

Examples and Tutorials 
!Imagesbtnexamples.png! Examples

Advanced topics

Confluence lets you easily embed content from popular user-generated sites like YouTube, Flickr, Slideshare, Google, Twitter and many other others. Add a YouTube video to this page ...

How the Talent Team at Atlassian use Confluence
Imagesbtnprevious.png! Have Fun !Imagesbtnnext.png align=right!

Confluence lets you easily embed content from popular user-generated sites like YouTube, Flickr, Slideshare, Google, Twitter and many others. Add a YouTube video to this page ...

HR Policies and Procedures
Imagesbtnprevious.png! Company Induction !Imagesbtnnext.png align=right!

Human resources uses attachments to share important tax forms and templates with employees. Click the {view} link on one of the attachments below to view its contents. Upload a new attachment to the page ...

J

Josh

Users can customize their personal spaces to express themselves and let their teammates know what they're working on. Click on one of the vacation photos image gallery

Creating a thumbnail gallery below to view a slideshow Update your own personal space ...

Leave Planning
Imagesbtnprevious.png! Planned Feature Specifications !Imagesbtnnext.png align=right!

Confluence Induction The Confluence team uses tables to communicate scheduled leave times, an imperative ...

I

Image Browser Spec
Imagesbtnprevious.png! Planned Feature Specifications Goal Make it easier to import media onto a page by providing better previews, easier attaching of files with less steps, and make everything prettier by using the new dialog box styles. Also allow a tab ...

Insert Menu Spec
Imagesbtnprevious.png! Planned Feature Specifications Goal The amount of rich objects (embedded videos, office documents, images, links) that can be added to Confluence has grown rapidly over the last two releases. The insert menu is a drop down that gives users ...

Integrating with JIRA

JIRA is Atlassian’s issue tracking system. Confluence and JIRA can be used together, allowing the integration of a content management solution with an issue tracker. For example, the JIRA Issues macro http://confluence.atlassian.com/x/dCAC can be used to display a list ...

Macro Browser Spec
Imagesbtnprevious.png! Confluence Roadmap Goal Present a visual listing of the macros that are available to the user showing the name, icon, screenshot, live view, and editable parameters and allow for simple insertion into the wiki page. Mockups !0.04c.3.jpg thumbnail! 10.04b.2.jpg thumbnail! 10.04a.1.jpg thumbnail ...

Meeting Notes
part of resource planning and project management. Edit Using the menus this page and add your ... 

More information
Once you have completed the tutorial Tutorial and read the advanced topics Advanced Topics, you may want to refer to the Confluence online documentation. Detailed instructions on using and administering Confluence Confluence User Guide http://confluence.atlassian.com/display/DOC ... 

N 

P 

Planned Feature Specifications
Imagesbtnprevious.png! Confluence 3.1 Release Dashboard
Imagesbtnnext.png align=right!
Leave Planning Use Confluence to create and collaborate on product specification documents. Click into the [Quick Navigation Spec] link below to see how the Confluence team writes a basic feature ... 

Plugins for Documentation
page: Copy existing spaces Back to top #top Manage approvals and workflows Back to top #top Manage tasks and get everyone involved Back to top #top Collaborative webbased diagrams Back to top #top Other plugins preinstalled ... 

Plugins for Intranets
page: Manage tasks and get everyone involved Back to top #top Skin and theme your intranet Back to top #top Collaborative webbased diagrams Back to top #top Create mockup diagrams Back to top #top Other plugins ... 

Plugins for Knowledge Management
page: Keep your content fresh and relevant Back to top #top Manage approvals and workflows Back to top #top Allow users to rate your content Back to top #top Other plugins preinstalled Back to top #top More ... 

PowerPoint Templates
Imagesbtnprevious.png! Atlassian Logos!Imagesbtnnext.png align=right!
Examples The Design Team uses Confluence to make company standard templates available to employees. Rather than storing these files on a network shared drive, they have instead attached them to a Confluence page ... 

Q 

Quick Navigation Spec
Imagesbtnprevious.png! Planned Feature Specifications Writing a product specification requires input and feedback from many different people. With Confluence, product managers, engineers and technical writers can make their changes or comments directly in the product specification page. With version control ... 

R 

Re-ordering pages
following instructions will show you how to view the hierarchy of pages within a space, and move pages to different positions within the hierarchy. (1) It is suggested that you use the new space that you created during the Tutorial (see 'Creating a space'). &nbsp;PART ... 

S 

Sales Reports
Imagesbtnprevious.png! Example Sales Team Page !Imagesbtnnext.png align=right!
Sales Reports The sales team uses Confluence to take notes during their weekly team meeting. Create a new meeting notes page Creating a page using the meeting notes ... 

Sales Tools
Imagesbtnprevious.png! Team Blog !Imagesbtnnext.png align=right! Examples! 

Confluence lets you easily embed content from popular usergenerated sites like Youtube, Flickr, Slideshare, Google, Twitter and many other others. Add a YouTube video to this page ... 

Searching Confluence content
Confluence can search content including pages, blog posts, emails, Microsoft Word
Images and charts can sometimes communicate complex concepts better than text. For example, your HR team might use images to explain the company recruiting processes ...

Request Leave Form

As well as using the search box at the top right of every Confluence page for ad hoc searches, you ...

Documents and Excel spreadsheets, PDF documents, and more.

Team Blog

Blogs are a handy way teams to provide updates, share ideas and engage in conversations around those ideas. Comment on one of the blog posts below. First click the blog post ...

Tutorial

Blogs are a handy way teams to provide updates, share ideas and engage in conversations around those ideas. Comment on one of the blog posts below. First click the blog post ...

Tutorial (all on one page)

Welcome to the tutorial on a page! This page contains all the topics from the tutorial Tutorial. On this page:

Using the menus

image below gives an overview of the menus in Confluence. The menus give you access to all the available actions on your Confluence site.

Using the Dashboard

Now you will use the Dashboard to navigate to the new page and the new space that you created in previous steps of this tutorial. # Rightclick the 'Dashboard' link at the top left of your screen, and open the link in a new browser window.

Using the menus

image below gives an overview of the menus in Confluence. The menus give you access to all the available actions on your Confluence site.

Week 27 Meeting Notes

This page was created using the Meeting Notes page template Attendees Josh Boots Kevin Matt Completed last week Sales Collateral updates 30 customer questions answered Webinar revamp Working on this week Continue ...

Week 28 Meeting Notes

This page was created using the Meeting Notes page template Attendees Matt Josh Kevin Boots Completed last week Sales Collateral updates only 25 customer questions answered because of offsite Webinar revamp ...

Week 29 Meeting Notes

This page was created using the Meeting Notes page template Meeting Notes for Week 29 Attendees Josh Boots Kevin Matt Completed last week Sales Collateral updates 30 customer questions answered Webinar ...

Working with RSS

RSS is generally used to notify others of the latest news and updates to a site. Confluence reads incoming RSS and creates outgoing RSS. It allows you to stay informed of the latest current affairs of others and allows you to tell them of your own ...

Updating your user profile

Now you will change your Confluence 'Full Name' (that is, the name by which you are known to other Confluence users) and profile picture (that is, the picture by which you are known to other Confluence users). # Log in to Confluence, if you are not logged in already, by clicking the 'Log ...

Adding a comment to a page

Using the Dashboard

Now you will use the Dashboard to navigate to the new page and the new space that you created in previous steps of this tutorial. # Rightclick the 'Dashboard' link at the top left of your screen, and open the link in a new browser window.

Using the menus

image below gives an overview of the menus in Confluence. The menus give you access to all the available actions on your Confluence site.

Using the Dashboard

Now you will use the Dashboard to navigate to the new page and the new space that you created in previous steps of this tutorial. # Rightclick the 'Dashboard' link at the top left of your screen, and open the link in a new browser window.

Using the menus

image below gives an overview of the menus in Confluence. The menus give you access to all the available actions on your Confluence site.

Using the Dashboard

Now you will use the Dashboard to navigate to the new page and the new space that you created in previous steps of this tutorial. # Rightclick the 'Dashboard' link at the top left of your screen, and open the link in a new browser window.

Using the menus

image below gives an overview of the menus in Confluence. The menus give you access to all the available actions on your Confluence site.
The example at left shows how to create an index based on page titles.

Alternatively, you may want to use labels to create an index. Once you have tagged your pages with appropriate labels, you can simply link to the space’s ‘Labels’ page (‘Browse’, ‘Labels’) to display an index.

Displaying source code

The ‘code’ macro is a useful way of presenting source code in an easy-to-read format on your Confluence pages. Its use is very straightforward: simply enclose your source code between (code) elements.

Here are some examples:

**XML**

```xml
{code:XML}
<test>
  <another tag="attribute"/>
</test>
{code}
```

gives

1. `<test>`
2.  `<another tag="attribute"/>
3. `</test>`

**SQL**

```sql
{code:SQL}
SELECT * FROM TABLE1 WHERE ID=0 AND NAME NOT IN (SELECT NAME FROM NAMES)
{code}
```

gives

```sql
1. SELECT * FROM TABLE1 WHERE ID=0 AND NAME NOT IN (SELECT NAME FROM NAMES)
```
package com.atlassian.confluence.admin.actions.macros;

import com.atlassian.confluence.renderer.UserMacroLibrary;

public class UserMacroBean
{
    String name;
    String template;

    public UserMacroBean()
    {
    }
}

public UserMacroBean(String name, UserMacroLibrary userMacroLibrary)
{
    this.name = name;
    this.template = userMacroLibrary.getMacroTemplate(name);
}

public String getName()
{
    return name;
}

public void setName(String name)
{
    this.name = name;
}

public String getTemplate()
{
    return template;
}

public void setTemplate(String template)
{
    this.template = template;
}
package com.atlassian.confluence.admin.actions.macros;

import com.atlassian.confluence.renderer.UserMacroLibrary;

public class UserMacroBean {
    String name;
    String template;

    public UserMacroBean()
    {
    }

    public UserMacroBean(String name, UserMacroLibrary userMacroLibrary)
    {
        this.name = name;
        this.template = userMacroLibrary.getMacroTemplate(name);
    }

    public String getName()
    {
        return name;
    }

    public void setName(String name)
    {
        this.name = name;
    }

    public String getTemplate()
    {
        return template;
    }

    public void setTemplate(String template)
    {
        this.template = template;
    }
}

For more information about the 'code' macro, please see the documentation.

Archiving email

Confluence can archive emails — which is useful for tracking information over a long period of time, and for permanently referencing emails from within documents.

Email archiving allows you to:

- Keep a history of interaction with your clients, colleagues or friends.
- Refer to email content when creating Confluence content.
- Centralise yet another form of communication in Confluence.

Email archiving is discussed in greater detail in the documentation.

More information

Once you have completed the tutorial and read the advanced topics, you may want to refer to the Confluence online documentation.

Detailed instructions on using and administering Confluence

Confluence User Guide
Confluence Administrator Guide
Featured Plugins

Confluence's plugin system makes it easy to customise and extend Confluence for your specific intranet, documentation and collaboration needs. We've highlighted a few plugins that you may like to check out based on how you are intending to use Confluence.
Plugins for Documentation

⚠️ Installing Plugins
The plugins featured on this page are not installed out-of-the-box. To install them, please refer to our documentation on installing plugins.

On this page:
- Copy existing spaces
- Manage approvals and workflows
- Manage tasks and get everyone involved
- Collaborative web-based diagrams
- Other plugins pre-installed
- More Confluence plugins

Copy existing spaces

The Copy Space plugin allows a space administrator to copy a space, including the pages within the space, but excluding (so far) page history, blog posts and email.

Confluence for Documentation

The Atlassian Tech Writers use spaces as their version-control mechanism. Here’s an overview of the process they follow:

- Leading up to release date, they work with ‘hidden drafts’ in the documentation space. For new features, they create new pages with restricted permissions. If they need to update existing pages, they create a hidden copy of the page and apply the updates to the copy.
- When release date is near, they copy the documentation space to create a snapshot of the current release as an archive using the Copy Space plugin.
- On release date, they rebrand the main documentation space to reflect the new release number. Then they unhide all the new pages and copy the content of the updated pages to the proper pages, then delete the copies.
- They then export the new release to PDF, HTML and XML, for those customers who prefer offline versions of the documentation.

Confluence as an Intranet

Confluence spaces are great for creating team spaces. You can create a template space for new teams and use the Copy Space plugin to copy the template whenever needed to create a space for a new team.

Confluence for Knowledge Management

Confluence spaces are great for creating knowledge bases. You can create a template space for new knowledge base and use the Copy Space plugin to copy the template whenever you need to create a new knowledge base.
Instructions

1. **Enter the space** you wish to copy
2. **Navigate to Space Admin** from the *Browse* menu in the menubar
3. **Click on Copy Space** under the *Space Operations* menu in the left navigation panel

⚠️ See the documentation - Copy Space Plugin

---

**Manage approvals and workflows**

![Image](image1.png)

The **Approvals Workflow Plugin** integrates seamlessly with Confluence to provide an innovative way of managing content approvals, without compromising the open and collaborative philosophy of a wiki. Users can create their own approval checks in their pages, or define more sophisticated workflows for entire spaces to enforce rules and actions.

Watch the video

⚠️ See the documentation - Approvals Workflow Plugin

---

**Manage tasks and get everyone involved**

![Image](image2.png)

With the **TaskDock Plugin** you can easily assign targeted actions like commenting on content or threads, adding or updating an attachment, editing a page, adding a page, or a general task right from any Confluence page. Seamlessly complete tasks within Confluence by clicking simple action links or by replying to certain emails to comment or upload attachments. Regardless of how you do it, smart follow-up tracks what you complete, so you can focus on doing actions versus managing tasks.

**Confluence as an Intranet**

Confluence pages are great for collaborating on the agenda for a meeting. Using TaskDock you can make sure that everyone's voice is heard:

1. **Create a new page** with suggested agenda items for a upcoming meeting
2. **Add a task** to each of the meeting attendees to either *comment on the page* or *edit the page* to add their own agenda items
3. Once the meeting is complete, **add another task** for the meeting attendees to update their notes from the meeting

**Confluence for Documentation**

When you create a new page in your documentation space which requires review, you can use the TaskDock plugin to insure it is reviewed by the right people.

1. **Create a new page** the is in the draft phase
2. **Add a task** for a colleague to *comment on the page* with any changes that need to be made before the page is ready for publishing

**Confluence for Knowledge Management**

If you are creating Knowledge Base articles in Confluence you can use the TaskDock plugin to ensure articles are kept up-to-date

1. **Create a new page** that will be a new article in the knowledge base
2. **Add a task** with a due date 1 month from now for yourself to *review the page* to ensure it is still a relevant article

Watch the 3 min video
Collaborative web-based diagrams

The **Gliffy plugin** allows you to easily create professional-quality flowcharts and diagrams, right in your Confluence pages.

At Atlassian, our Human Resources department used this tool to map out our recruitment process. This diagram is embedded in a Confluence page in the team's space where employees involved in the recruitment process can quickly understand what the next step is. For example, what step comes after the initial interview, and who is responsible for that step.

### How to add a Diagram to a Confluence page

1. Hover your cursor over the *Add* menu on any Confluence page
2. **Select Gliffy Diagram**
3. Enter a name for your diagram
4. **Use the Gliffy Web-based editor** to complete your diagram
5. Once you've completed your diagram, **select Save and Close from the *File* menu in the top-left of the Gliffy editor**

Watch the video

### Other plugins pre-installed

Confluence comes with a set of bundled plugins (macros) that you can use right away with the Macro Browser. [Learn more.](#)

### More Confluence plugins

There are hundreds of open-source and commercial plugins available for Confluence. Browse them by category on the [Atlassian Plugin Exchange.](#)

### Plugins for Intranets

⚠️ **Installing Plugins**

The plugins featured on this page are not installed out-of-the-box. To install them, please refer to our documentation on [installing plugins.](#)
Manage tasks and get everyone involved

With the TaskDock Plugin you can easily assign targeted actions like commenting on content or threads, adding or updating an attachment, editing a page, adding a page, or a general task right from any Confluence page. Seamlessly complete tasks within Confluence by clicking simple action links or by replying to certain emails to comment or upload attachments. Regardless of how you do it, smart follow-up tracks what you complete, so you can focus on doing actions versus managing tasks.

Confluence as an Intranet

Confluence pages are great for collaborating on the agenda for a meeting. Using TaskDock you can make sure that everyone's voice is heard:

1. Create a new page with suggested agenda items for a upcoming meeting
2. Add a task to each of the meeting attendees to either comment on the page or edit the page to add their own agenda items
3. Once the meeting is complete, add another task for the meeting attendees to update their notes from the meeting

Confluence for Documentation

When you create a new page in your documentation space which requires review, you can use the TaskDock plugin to insure it is reviewed by the right people.

1. Create a new page the is in the draft phase
2. Add a task for a colleague to comment on the page with any changes that need to be made before the page is ready for publishing

Confluence for Knowledge Management

If you are creating Knowledge Base articles in Confluence you can use the TaskDock plugin to ensure articles are kept up-to-date

1. Create a new page that will be a new article in the knowledge base
2. Add a task with a due date 1 month from now for yourself to review the page to ensure it is still a relevant article

Watch the 3 min video

See the documentation - TaskDock Plugin

Skin and theme your intranet

You have a number of options for completely customising the look and feel of Confluence. Below, we've highlighted the most popular options for skinning Confluence for use as a corporate intranet.

RefinedWiki Original Theme

RefinedWikis Original Theme is a plugin which gives Confluence a whole new design and makes it easier for your company to collaborate and share documents. Watch the video

Learn more
Intranet Theme

The Confluence Intranet Theme provides support for hierarchically structured content using menu based navigation, making content much more accessible.

Learn more

ThemeBuilder

If you are looking to build your own theme, the Theme Builder plugin allows you to add and customise logo banners, menu-driven navigation, style sheets, footers and more...

Learn more

Collaborative web-based diagrams

The Gliffy plugin allows you to easily create professional-quality flowcharts and diagrams, right in your Confluence pages.

At Atlassian, our Human Resources department used this tool to map out our recruitment process. This diagram is embedded in a Confluence page in the team's space where employees involved in the recruitment process can quickly understand what the next step is. For example, what step comes after the initial interview, and who is responsible for that step.

How to add a Diagram to a Confluence page

1. Hover your cursor over the Add menu on any Confluence page
2. Select Gliffy Diagram
3. Enter a name for your diagram
4. Use the Gliffy Web-based editor to complete your diagram
5. Once you've completed your diagram, select Save and Close from the File menu in the top-left of the Gliffy editor

Watch the video

Create mockup diagrams

Ever heard the saying ‘a picture is worth a thousand words’? Using the Balsamiq Mockups Plugin you can create and visualise mockups of diagrams for proposed layouts of website content, new features, and much more, right within Confluence.

- Our Development Team uses Balsamiq to mockup new features for our products. The Balsamiq Mockup below eventuated in the new Image Browser that shipped in Confluence 3.1.
- Our Marketing Team use Balsamiq to create mockups of pages for our website in Confluence. The mockups are then given to our Web
How to add a Mockup to an existing page

1. Hover your cursor over the Add menu on any Confluence page
2. Select UI Mockup
3. Use the Balsamiq Web-based editor to complete your mockup
4. Once you've completed your mockup, select Save and Close from the Mockup menu in the top-left of the Balsamiq editor

Watch the video

Import Existing Mockups

You can reuse a whole bunch of Mockups that have been contributed by the community.

Other plugins pre-Installed

Confluence comes with a set of bundled plugins (macros) that you can use right away with the Macro Browser. Learn more.

More Confluence plugins

There are hundreds of open-source and commercial plugins available for Confluence. Browse them by category on the Atlassian Plugin Exchange.

Plugins for Knowledge Management

The plugins featured on this page are not installed out-of-the-box. To install them, please refer to our documentation on installing plugins.

On this page:

- Keep your content fresh and relevant
- Manage approvals and workflows
- Allow users to rate your content
- Other plugins pre-installed
- More Confluence plugins

Keep your content fresh and relevant

The Archiving Plugin archives Confluence pages that haven't been changed for awhile, or have been labelled with 'archive'. This plugin helps you to keep your content fresh and relevant. Pages that never expire and are to be ignored by archiving should be labeled with noarchive or noarchive-single.

For each fresh space having pages to archive, it will create an archive space transparently in the background. Then it copies the outdated pages there, and trashes the original ones. Additionally, it sends emails to authors and last modifiers of the pages close to expire.

It effectively automates content archival processes, and prevents your wiki spaces turning into scrapyards.
Manage approvals and workflows

The Approvals Workflow Plugin integrates seamlessly with Confluence to provide an innovative way of managing content approvals, without compromising the open and collaborative philosophy of a wiki. Users can create their own approval checks in their pages, or define more sophisticated workflows for entire spaces to enforce rules and actions.

Watch the video

Allow users to rate your content

The Rate Macro Plugin provides set of macros for collecting, displaying and reporting page ratings.

Some implementations we’ve seen

- Allow users to rate your knowledge base articles so you can discover which articles require improvement
- Open up voting on a new UI mockup for a new feature in your product

Other plugins pre-installed

Confluence comes with a set of bundled plugins (macros) that you can use right away with the Macro Browser.

More Confluence plugins

There are hundreds of open-source and commercial plugins available for Confluence. Browse them by category on the Atlassian Plugin Exchange.

Examples
These are real world examples of how Confluence can be used in your organisation. As you go through these examples, look at the underlying markup to see how the pages were created. (See the markup by selecting View Wiki Markup from the Tools menu.) Feel free to edit the pages. If you break anything you can always revert back to a previous version of the page. Click one of the buttons below to continue.

Example Sales Team Page

Teams can use Confluence to collaborate internally and share information with the rest of the organization. Here's an example of how a sales team uses Confluence.

- Click into each one of the Quick Links below to see how a sales team might use Confluence. (make sure to look at Sales Reports)
- Click on the link to Josh's name below to see how a user can personalize his/her own page.

What We're About

The Sales team is the first point of contact for prospective customers and act as the key sales resource for new customers. Our goal is to help customers make the decision to purchase our products through non-aggressive, 100% honest and customer service oriented selling.

Meet the Team
Quick Links

- Meeting Notes
- Sales Reports
- Team Blog
- Sales Tools

Sales Reports

**Goal: $10,000,000**

Sales by Rep

- Kevin ($1,694)
- Boots ($2,062)
- Giancarlo Team Lead SF JIRA FishEye Crucible
- Matt ($1,694)
- Dave ($1,620)

**Warning: Sample Content**

This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.
Welcome to my personal space!

**About Me**

I graduated from UC Davis with a double major in English and Computer Science. I've been at Atlassian since January 2006. I currently live in the Mission neighborhood in San Francisco and try to ride my bike into the office every day. I'm always up for a good bike ride after work if anyone ever wants to join. In my younger years, I did done all sorts of cool stuff, like camp counselor, afterschool teacher, that kind of thing. In 2004, I spent 8 months backpacking around Europe with my wife. That was great fun, but also hard work. Washing your clothes in the sink can be interesting. Here are some photos from that trip.

I'm a huge gamer. Boardgames, card games, computer games, console games, anything games. Heck, I'll go ahead and set up my own pages on games later. No need to bore you folks with long and huge descriptions of gaming stuff...yet.

Finally, I do a bit of amateur photography (for those of you who are also photogs, I'm a Nikon shooter. Digital/Film, though mostly Digital.). Here are some photos I took on my last vacation.

**My recent trip to Sydney**

- Random photo of Sydney
- Shot of the Harbour Bridge from the side
- Circular Quay in Sydney
- Shot of the Sydney Opera House from the Harbour Bridge
- Shot of the Harbour Bridge from below
What Stuff

My Active Projects

- Sales Process Redesign
- Updating Product Collateral
- Annual Reviews

I'm an expert on

- Confluence
- Jira
- Salesforce.com
- Sales

My Blog

Wednesday, 22 October 2008
Developers - What's your favourite editor when using Windows?
Last changed Oct 23, 2008 11:02 by Bill Arconati
Labels: josh, windows, editors, dev

ConText, my previous editor of choice, burnt me when I discovered that its 'Search backwards' function doesn't always find matches. Now I'm searching for a new file editor to do my Confluence support in.

Are there any decent Windows-based editors that you would recommend, or is Cygwin Vim the undisputed king?

I'll be using it for log trawling and editing XML, VM and Java property files. The ability to filter text (eg show only lines containing SEVERE) would be useful, …

Read more…

Posted at Oct 22, 2008 by Bill Arconati | 0 comments | Edit

Confluence Mentioned In Rex In-Flight Magazine
Last changed Oct 28, 2008 05:57 by Bill Arconati
Labels: josh, rex, confluence

Browsing the in-flight magazine for Regional Express on the way to see my family over the long weekend produced this pleasant surprise - amongst the dozen or so websites reviewed in their article on 'Websites That Work' was a plug for Confluence and Atlassian. They seemed a bit vague on what wikis actually do, describing them as "able to bring those water cooler conversations online", but went on to describe us as one of best of the bunch and included a link to our site. …

Read more…

Posted at Oct 22, 2008 by Bill Arconati | 0 comments | Edit

Back in Action!
Last changed Oct 23, 2008 11:03 by Bill Arconati
Labels: josh, vacation

I'm now back in the office again after a 3 month backpacking tour of Europe. I managed 17 countries and had an amazing time, but it's good to be back after living out of a suitcase for so long. It's great to hear that Atlassian meet our amazing growth projections for the financial year and see our new sales process.

I'm looking forward to getting back into everything again. 500+ emails and many, many blog posts... …

Read more…

Posted at Oct 22, 2008 by Bill Arconati | 0 comments | Edit
Meeting Notes

The sales team uses Confluence to take notes during their weekly team meeting.

- Create a new meeting notes page using the meeting notes page template. Go to the add menu and select "Page." Then click on the "Select a page template to start from." Choose the "Meeting Notes" template.
- Search for 'notes' in the search box below to search inside of past meeting notes.

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Week 27 Meeting Notes

This page was created using the Meeting Notes page template

Attendees
- Josh
- Boots
- Kevin
- Matt

Completed last week
- Sales Collateral updates
- 30 customer questions answered
- Webinar revamp

Working on this week
- Continue improvements to Webinar
30 customer questions answered
Final planning for team offsite

Sales update

- Closed 6 deals
- Lot of questions on upcoming release

Miscellaneous

- Team Offsite next week 😊

---

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

---

Week 28 Meeting Notes

This page was created using the Meeting Notes page template

Attendees

- Matt
- Josh
- Kevin
- Boots

Completed last week

- Sales Collateral updates
- only 25 customer questions answered because of offsite
- Webinar revamp

Working on this week

- Sales Collateral updates
- 30 customer questions answered
- Webinar revamp

Sales update

- Closed 5 deals
- Expecting 2 more to close

Miscellaneous

- none

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.
Week 29 Meeting Notes

Meeting Notes for Week 29

Attendees

- Josh
- Boots
- Kevin
- Matt

Completed last week

- Sales Collateral updates
- 30 customer questions answered
- Webinar revamp

Working on this week

- Continue improvements to Webinar
- 30 customer questions answered

Sales update

- Closed 6 deals
- Lot of questions on upcoming release

Miscellaneous

- none

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Sales Reports

The sales team uses charts to create a sales dashboard showing their performance relative to plan. Once you become an advanced user, you can connect the charts to your sales database using SQL so that you can display your sales data in real time.

- Edit this page and change a number in one of the charts below. Notice how the chart changes when you preview or save your change.
- Edit this page and change a bar chart below into a line chart. Change "type=bar" to "type=line" inside the {chart} macro. Watch the chart type change when you preview or save your change.
Sales Tools

Confluence lets you easily embed content from popular user-generated sites like Youtube, Flickr, Slideshare, Google, Twitter and many other others.

- Add a YouTube video to this page by clicking the 'edit' button and pasting "[widget:url=http://www.youtube.com/watch?v=0Hg5SJYRHA0]\" at the bottom of the page.

Confluence Overview

This video gives users a basic understanding of how Confluence works and how it can help them do their jobs.

What's New in Confluence 3.1


Introducing Drag-and-Drop


Wiki Adoption

This slideshow can give customers an idea of how to propagate an enterprise wiki throughout their organisation.
Blogs are a handy way teams to provide updates, share ideas and engage in conversations around those ideas.

- **Comment on one of the blog posts below.** First click the blog post title, to open it in its own page. See [Adding a comment to a page](#).
- **Create a new blog post and label it "sales" to see it show up in this page.** Go to the "Add" menu and select "News." Fill out the blog post form and type "sales" in the labels field. Submit the post and navigate back to this page.

---

**Wednesday, 18 November 2009**  
From the Frontlines at Agile Australia 2009  
Last changed Nov 19, 2009 17:08 by Matt Hodges  
Labels: sales

Last week Nick and I represented Atlassian at Agile Australia 2009. We had a decent booth in a great location right in-front of the conference doors and also next to the food station.

On the other side of our booth we had thoughtworks who were the major sponsor of the event. They must have had about 20 of their staff members there attending and speaking at the conference, …

Read more…

**Posted at Nov 18, 2009 by Matt Hodges | 0 comments | Edit**

**Wednesday, 22 October 2008**  
Rare Website Luv  
Last changed Oct 23, 2008 11:05 by Bill Arconati  
Labels: sales, luv, website

Usually we get compliments on our webinars and customer support. Today I got a nice compliment on our website I wanted to share with you all:

Hi Boots.

Thank you for contacting me. Let me congratulate your company for such a good commercial website, it is very simple for costumers to surf though the products information.

Best regards, …

Read more…

**Posted at Oct 22, 2008 by Bill Arconati | 0 comments | Edit**
Hello everyone,

We've set the new sales target for this year and wanted to communicate it to you as soon as possible. Given our stronger-than-expected performance last fiscal year and the robustness of our pipeline, we expect to exceed last year's performance by at least 10%. Therefore we have set this year's goal at a conservative $10 million. $10million won't be a cake walk but it's not out of reach for a strong sales team like the one we have here. …

Read more…

Posted at Oct 22, 2008 by Bill Arconati | 0 comments | Edit

Webinar Feedback
Last changed Oct 24, 2008 06:26 by Bill Arconati
Labels: sales, luv, customer, webinar

I got this email from a customer and thought I would share it!

Matt, hi

Just a quick note to thank you for the Webinar you hosted today. There was quite a group of us in attendance and it was very informative.

Cheers,
Thomas

Posted at Oct 22, 2008 by Bill Arconati | 0 comments | Edit

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Example Development Team Page

The Confluence Development Team at Atlassian uses Confluence to induct new members, collaborate on feature specifications and hit key milestones on time.

- Click into each of the links in the yellow box below to see more.
- Comment on one of the blog posts below. First click the blog post title, to open it in its own page. See Adding a comment to a page.
Quick Links

- Confluence Roadmap
- Confluence 3.1 Release Dashboard
- Planned Feature Specifications
- Leave Planning
- Confluence Induction

Dev Team Blog

Recently Updated

- Giles Gaskell
  - Confluence 3.1-m7 Milestone Notes updated November 20 (view change)

- Matt Hodges
  - Confluence 3.1-m7 Milestone Notes updated November 19 (view change)

- Bill Arconati
  - Developers - What's your favourite editor when using Windows? updated Oct 23, 2008 (view change)

Release status
The Confluence Development Team always knows its status relative to plan. At the end of each week, the team updates the issues table below to show which issues were addressed and which ones carried over. The team also uses the \{chart\} macro to create a burndown chart showing how much work is left relative to how much time is left.

- **Edit this page and change one of the numbers in the chart.** Save or preview the page to see your changes.
- **Edit this page and update the status one of the rows** by (like “quick-nav: selenium testing”) by adding a ✔ to the status column.

- Burndown chart
- Rules for how to update the release dashboard
- Dropped from release
**Burndown chart**

The following graph provides a rough status on the progress of the Confluence team.

![Burndown chart](chart.png)

**Rules for how to update the release dashboard**

Steps that need to be done at the end of an iteration

- Tasks that were finished get ticked off with a ✓ and remain where they are.
- Tasks that have been started but not finished get moved to the next iteration. No estimates are changed, and in the comment field a text is added "carried over from previous x weeks".
- Tasks that were planned but not even started get moved to next iteration without comment.
- Velocity of previous iteration may be calculated and added, but only based on finished tasks, no matter how close unfinished tasks were to completion.
- New unplanned work is added to the new iteration and marked in blue. cards that simply took longer than expected don't get any colour-coding.
- The "remaining estimated work" number from previous iteration remains unchanged.
- "Remaining estimated work" for the new iteration (including the backlog) is calculated based on the original estimates, and includes unplanned added work. So even a 2d-task that is considered 90% done will show up as 2d in the new iteration.
- The new iteration may exceed the previous velocity since we assume that there just remain 10%. But for the "remaining estimated work" the two days will be used.
- If the sum of all remaining work is larger than the original budget, some tasks at the end have to be declared as "won't fix" and greyed out. Their estimates are no longer counted for the remaining work.

2.10 is estimated to be a 3 month release, manned by a 2 person team (with one person doing part time bug fixing). Accounting for 1 week of sick or holiday leave, we have a feature budget of 14u (11 iterations).

<table>
<thead>
<tr>
<th>Iteration</th>
<th>Week 1: 30/JUL</th>
<th>Estimate</th>
<th>Remaining at very start of release cycle: 23</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Discovery feature breakdown</td>
<td>1u</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Remove SearchService</td>
<td>1u</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Investigate/rework did-you-mean indexing</td>
<td>1u</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Deploy RC1 to QA and Production</td>
<td>1u</td>
<td>✓</td>
</tr>
<tr>
<td>Week 2: 6AUG</td>
<td>4u</td>
<td>Velocity: 4u. Remaining: 21</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Make author filter work for external users (CONF-10769)</td>
<td>2u</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Quick search by page title task breakdown</td>
<td>1u</td>
<td>✓</td>
</tr>
<tr>
<td>Task</td>
<td>Week</td>
<td>Hours</td>
<td>Status</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>-------</td>
<td>--------</td>
</tr>
<tr>
<td>Respond to Did-You-Mean review feedback</td>
<td>1u</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Add author filter to people directory</td>
<td>1u</td>
<td>Decided to discontinue work on card after 0.5u investigation.</td>
<td></td>
</tr>
<tr>
<td><strong>Week 3: 13/AUG</strong></td>
<td>4u</td>
<td>Velocity: 5u. Remaining: 16.5u</td>
<td></td>
</tr>
<tr>
<td>Make author filter work for hosted</td>
<td>2u</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Fix archiva with James</td>
<td>0.5u</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Discovery planning</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Code reviews</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Week 4: 20/AUG</strong></td>
<td>4.5u</td>
<td>Velocity: 2.5u. Remaining: 14u</td>
<td></td>
</tr>
<tr>
<td>quick-search-by-title: Add lucene index fields</td>
<td>1u</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Week 5: 27/AUG</strong></td>
<td>1u</td>
<td>Velocity: 1u. Remaining: 13u</td>
<td></td>
</tr>
<tr>
<td>did-you-mean: merge to trunk</td>
<td>0.5u</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>did-you-mean: run clover and add tests</td>
<td>1u</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Week 6: 3/SEP</strong></td>
<td>1.5u</td>
<td>Velocity: 1.5u. Remaining: 11.5u</td>
<td></td>
</tr>
<tr>
<td>quick-search-by-title: backend</td>
<td>2u</td>
<td>✔ Carried over twice from previous iteration, took longer than expected</td>
<td></td>
</tr>
<tr>
<td><strong>Week 7: 10/SEP</strong></td>
<td>2u</td>
<td>Velocity: 2u. Remaining: 9.5u</td>
<td></td>
</tr>
<tr>
<td>quick-search-by-title: JSON</td>
<td>0.5u</td>
<td>✔ Carried over from previous iteration</td>
<td></td>
</tr>
<tr>
<td>quick-search-by-title: UI Integration</td>
<td>1u</td>
<td>✔ Carried over from previous iteration</td>
<td></td>
</tr>
<tr>
<td>search-visuals: clean up display of individual results</td>
<td>2u</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Week 8: 10/SEP</strong></td>
<td>3.5u</td>
<td>Velocity: 3.5u. Remaining: 8u</td>
<td></td>
</tr>
<tr>
<td>quick-nav: bug fixes (unicode, themes, highlighting)</td>
<td>1u</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Week 9: 17/SEP</strong></td>
<td>1u</td>
<td>Velocity: 1u. Remaining: 11u</td>
<td></td>
</tr>
<tr>
<td>quick-nav: selenium testing</td>
<td>1u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>search-visuals: Add people thumbnails to search results</td>
<td>1u</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Week 10: 24/SEP</strong></td>
<td>2u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>did-you-mean: indexing issues (CONF-12943)</td>
<td>1u</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Week 11: 6/OCT</strong></td>
<td>1u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>quick-search-by-title: Advanced JS component</td>
<td>3u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• IE bug (CONF-13158)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• density and organisation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Caching issues</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>quick-nav: performance testing</td>
<td>1u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>quick-nav: Timouts (CONF-13062)</td>
<td>1u</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Week 12: 13/OCT</strong></td>
<td>4u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenSearch plugin (advertisement only)</td>
<td>0.5u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>quick-nav: Document for custom layouts (CONF-13073)</td>
<td>0.25u</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Dropped from release

<table>
<thead>
<tr>
<th>Task</th>
<th>Estimate</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>quick-nav: relevancy: boost by favourites</td>
<td>2u</td>
<td>(not counted for remaining estimate, since originally unplanned and not in current plan anymore)</td>
</tr>
<tr>
<td>search-visuals: Adjust number of results per page</td>
<td>1u</td>
<td></td>
</tr>
<tr>
<td>Change default space content</td>
<td>0.5u</td>
<td></td>
</tr>
<tr>
<td>did-you-mean: auto-enable for english customers (CONF-13209)</td>
<td>1u</td>
<td></td>
</tr>
</tbody>
</table>

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Confluence Induction

Confluence can help development teams get new new members up to speed quickly so that they're fixing bugs sooner and detracting less from highly productive members.

- Add a new child page to this page by going to the Add menu and selecting Page. Then look for the child page in the Children section at the bottom of this page.

This induction handbook follows on from the Global Induction. Please also review the New Employee Checklist first before proceeding.
Induction

Congratulations, you have been chosen to become a part of the Confluence team! How exciting is that?

On second thoughts, don't answer that.

By now you should have a desk, a chair and a computer running your operating system of choice. If you don’t, grab somebody because you’ve missed the first couple of stages of your induction. Otherwise, make sure you are sitting comfortably and we’ll continue.

Ergonomics Warning
If you are not sitting comfortably, please sign an occupational health and safety claims waiver form immediately.

About The Confluence Development Team

The Confluence Development Team is responsible for the development of Confluence, the enterprise wiki. Imagine a gigantic funnel. Thousands of feature and improvement suggestions and bug reports pour into the top, and a top quality enterprise wiki comes out at the bottom. You’re sitting in the middle.

Administrivia

What hours do I need to work?

You are contracted to work an 8.5 hour day, including one hour for lunch. We’re pretty relaxed about when you start and finish work each day, so long as you:

- put in the hours
- show up for scheduled meetings (including the daily 10am stand-up)
- let your team leader know in advance if you’re going to be gone at some time you’d normally be expected to be around

We also do a lot of pair-programming, so if you know you’re working with a pair and one of you habitually works 8-5 and the other 10-7, you should probably work it out between yourselves to show up at the office at the same time.

Procedures for sick leave and annual leave should already have been explained to you as part of your company induction.

Confluence Resources/Bookmarks

The Confluence team uses many different resources and tools to go about their various functions including:

1. Staff Contact List - photos and contact information of all Atlassian staff
2. The CONFDEV space
3. The documentation, discussion and extensions spaces on confluence.atlassian.com
4. Charles’ Poker Corner – explains where half the team vanishes to on Friday lunchtimes
5. The Communication Methods page contains some RSS feeds you should subscribe to, including the Atlassian del.icio.us feeds.
Configure Confluence Systems

As part of your induction, you should have received logins for all the various Atlassian systems. Now would be a good idea to check them out:

- [http://confluence.atlassian.com](http://confluence.atlassian.com) – check this out particularly.
- [http://jira.atlassian.com](http://jira.atlassian.com)
- [cvs.atlassian.com](http://cvs.atlassian.com) (And Fisheye)
- [svn.atlassian.com](http://svn.atlassian.com) (And Public Fisheye)
- Bamboo on keg.sydney.atlassian.com (Unit test CI)
- Bamboo on panda.sydney.atlassian.com (Functional test CI)
- `RESCHES/DEVFILES` (including the vitally important `entertainment` directory)

What Do I Do Now?

Set up your development environment

Read our ‘Setting Up a Confluence Development Environment’ instructions, which show you how to grab Confluence from version control and get it compiled and running inside IDEA.

Your first important task at Atlassian is to help us maintain this document. Anywhere you find it unclear or inaccurate, ask a nearby developer what you should be doing then fix the wiki page.

Set up other parts of your computer

You may want to install OpenOffice (or NeoOffice if you are on a Mac, which can be found on DEVFILES\software\apple) in order to be able to view DOC and XLS files sent to you by random people.

Learn More about Confluence

Once you have Confluence installed, play with it. Look at the source code. Read the documentation. Get a feel for the bugs and feature requests in JIRA. Get more familiar with the core Open Source components of Confluence, especially Hibernate, Spring and Lucene.

The First Few Weeks

Confluence is a reasonably big codebase, and the nature of the application is such that there are a lot of different subsystems with complex interdependencies. As a result, it can be a little hard to get into. We've found the best way to get started is to fix bugs: they're isolated, well-defined problems with a clear point of completion.

When your confidence grows, you'll be eased into bigger things.

You might also be curious to read our ‘The Confluence Development Process’ document to find out how we develop software.

---

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Confluence Roadmap

Confluence 3.1 (Q4 2009)
Headline Themes and Features

- **Integration with Gadgets**
  - Cross Product Integration: Display confluence content inside JIRA dashboard
  - Cross Product Integration: Display JIRA lists and gadgets inside of Confluence
  - Federation: Display confluence inside another Confluence site as a gadget

- **Manage Office Documents**
  - Office 2007 Support (Office Connector, Indexing)
  - Attachment and Image Drag and Drop
  - Various UI improvements

- **Improved Editing Experience**
  - Insert Menu
  - Image Browser
  - IE8 Support, Safari 4 Support

Engine Room

- High Availability progress

*Confluence 3.0 (Q2 2009)*

Headline Themes and Features

- **Ecosystem**
  - Macro Browser Spec
- **Community**
  - Hover Profile
  - Profile

Other Improvements

- Recurring Features
  - Widget Connector Improvements
  - Better PDF export

References

<table>
<thead>
<tr>
<th>Past Releases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence 3.0</td>
</tr>
<tr>
<td>Confluence 2.9</td>
</tr>
<tr>
<td>Confluence 2.8</td>
</tr>
<tr>
<td>Confluence 2.7</td>
</tr>
</tbody>
</table>

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Community - Hover Profile

Goal

Show quickly and conveniently key details about a Confluence user wherever that user's name appears.

Mockup
Use Cases

1. Sees popup with details about the user as per the mockup
2. More menu which is pluggable with other commands

Community - Profile

Goal

Give users richer profiles that contained ‘structured’ data that can be used by Confluence.

Mockup

Use Cases

1. User can specify profile details about themselves.
2. Admins can edit users profile details
3. If a user does not have a personal space their profile page is shown with the following information
4. User sees a panel on every page of a person’s personal space showing their activity, and their followers (if followers is implemented)
5. Profile section has edit link that links to the person’s profile tab’s detail section see screen above (in their personal space)
6. Activity section has a more link that links to the person’s profile (in their personal space showing the person’s activity with the default number of recently updated entries)
7. Follow section shows 5 random following and followers (see design) and links to Follow tab (in the users personal space)
8. User can favourite the person from the profile panel

Macro Browser Spec

Goal

Present a visual listing of the macros that are available to the user showing the name, icon, screenshot, live view, and editable parameters and allow for simple insertion into the wiki page.

Mockups
Use Cases

1. Selects from a categorised list of macro and inserts the macro into a wiki page or comment
2. Sees a textual description and small screenshot or icon of the macro she selects
3. Fills in the parameters through fields (minimum: single line text field, multi-line text field, number field, select list, colour; max: date, slider) for the macro. Show defaults filled in or selected. If macro parameter type not defined, show text area
4. Sees a live preview of certain macros that changes when a user clicks button. Shown in a frame to handle very large macros (e.g. Jira Issues)
5. Sees an icon for the macro she selects. Favicon in list. Larger icon in description
6. Sees number of macro in Category title
7. On inserting can see a placeholder on the edit page. Even for body macros (e.g. note)
8. Selects the placeholder and can edit parameters
9. Move placeholders around the text area
10. Inserts user macros
11. Search the list for macro titles and description
12. Can favourite macros, and see them in their own category. Open by default.
13. Sees the most popular (most viewed) macros for their wiki

Leave Planning

The Confluence team uses tables to communicate scheduled leave times, an imperative part of resource planning and project management.

- **Edit this page and add your vacation plans to the table.** Try using wiki markup to do it.
- The form on the right of this page was created using the Wufoo HTML Form Builder. Try filling out the form or learn how to create one for yourself.

This page summarises leave of Confluence team members. It is not a replacement for the normal leave process. To get leave approved, you must first complete the form on the right of this page.

<table>
<thead>
<tr>
<th>Name</th>
<th>Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terry Johnson</td>
<td>14/9 - 24/9 (Holiday), 4/10 - 12/10 (Personal)</td>
</tr>
<tr>
<td>Ben Wilson</td>
<td>28/8 - 17/9</td>
</tr>
<tr>
<td>Evan Booth</td>
<td>8-15/10</td>
</tr>
<tr>
<td>Rudy Snow</td>
<td>26/10 - 2/11 (annual leave)</td>
</tr>
<tr>
<td>Mark Giles</td>
<td>5/11 - 16/11</td>
</tr>
<tr>
<td>Judd Nelson</td>
<td>23/11 - 11/12</td>
</tr>
<tr>
<td>Meredith Romano</td>
<td>6/12 - 26/12</td>
</tr>
<tr>
<td>Patrick Norton</td>
<td>18/12 - 4/1. Working remotely for two days somewhere in between, and check my mail daily.</td>
</tr>
<tr>
<td>Name</td>
<td>Dates</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Arnold Kasper</td>
<td>24/12 - 2/1</td>
</tr>
<tr>
<td>Ryan Forman</td>
<td>24/12, 31/12</td>
</tr>
<tr>
<td>Michelle Longley</td>
<td>27,28,31 DEC</td>
</tr>
<tr>
<td>Donna Willis</td>
<td>31/12 - 2/1</td>
</tr>
<tr>
<td>Ben Wilson</td>
<td>4/1+7/1, 17+18+21/1</td>
</tr>
<tr>
<td>Evan Booth</td>
<td>25/1</td>
</tr>
<tr>
<td>Michelle Longley</td>
<td>29/1 - 1/2</td>
</tr>
<tr>
<td>Terry Johnson</td>
<td>1,4,5/2</td>
</tr>
<tr>
<td>Ryan Forman</td>
<td>15+18/2</td>
</tr>
<tr>
<td>Patrick Norton</td>
<td>20/3</td>
</tr>
<tr>
<td>Daniel Kim</td>
<td>Thu 27th March to Wed 16th April</td>
</tr>
<tr>
<td>Donna Willis</td>
<td>11/4/8 - 14/4/8 (very long weekend)</td>
</tr>
<tr>
<td>Meredith Romano</td>
<td>29/4</td>
</tr>
<tr>
<td>Patrick Norton</td>
<td>2/5</td>
</tr>
<tr>
<td>Ben Wilson</td>
<td>22/5/08</td>
</tr>
<tr>
<td>Michelle Longley</td>
<td>28/5/08</td>
</tr>
<tr>
<td>Chaz Gilbert</td>
<td>2/7 - 23/7</td>
</tr>
<tr>
<td>Patrick Norton</td>
<td>6/6 &amp; 10/6</td>
</tr>
<tr>
<td>Patrick Norton</td>
<td>28 July</td>
</tr>
<tr>
<td>Arnold Kasper</td>
<td>up to three weeks in June/July</td>
</tr>
<tr>
<td>Michelle Longley</td>
<td>4-8 August</td>
</tr>
<tr>
<td>Terry Johnson</td>
<td>3-15 September</td>
</tr>
<tr>
<td>Niles Tandem</td>
<td>11-17 September</td>
</tr>
<tr>
<td>Tom Zebrowski</td>
<td>15 September -&gt; 03 October 2008</td>
</tr>
<tr>
<td>Ben Wilson</td>
<td>6 Oct - 20 Oct</td>
</tr>
<tr>
<td>Scott Sampson</td>
<td>15 August 2008</td>
</tr>
<tr>
<td>Chaz Gilbert</td>
<td>3 November 2008 - 2 December 2008</td>
</tr>
<tr>
<td>Nolan Matthews</td>
<td>9 February - 20 February 2009</td>
</tr>
</tbody>
</table>
Planned Feature Specifications

Use Confluence to create and collaborate on product specification documents.

- Click into the Quick Navigation Spec link below to see how the Confluence team writes a basic feature specification.
- Add a label to this page. Scroll down to the labels section on this page and add a label. Then go into the browse menu and choose labels to see all the labels used in this space.

Confluence 3.1 Feature Specifications

- **Image Browser Spec** — Make it easier to import media onto a page by providing better previews, easier attaching of files with less steps, and make everything prettier by using the new dialog box styles. Also allow a tab for inserting images through URLs.
- **Insert Menu Spec** — The amount of rich objects (embedded videos, office documents, images, links) that can be added to Confluence has grown rapidly over the last two releases. The insert menu is a drop down that gives users one simple place to go to add an object to a wiki page without clutter and confusion.
- **Quick Navigation Spec** — User can quickly and simply navigate to a page, person, space, or attachment via title.

Image Browser Spec

Goal

Make it easier to import media onto a page by providing better previews, easier attaching of files with less steps, and make everything prettier by using the new dialog box styles. Also allow a tab for inserting images through URLs.

<table>
<thead>
<tr>
<th>Title</th>
<th>Must Have Stories</th>
<th>Screenshots</th>
</tr>
</thead>
</table>

**Prioritised User Stories**
Mark wants to attach an image to his Sales Presentation page. He clicks the Insert Image button in the editor and opens the Insert Image dialog box with the Images tab selected. He clicks the Browse button and selects a file from his hard drive and clicks OK. The file is uploaded and appears in the list of alphabetised images as the selected item. He aligns the image to the centre, makes it a thumbnail.

- A border (1px solid #ccc) is added by default to images to distinguish them from the page.

Kate wants to align an image to the right. She selects the image and sees a panel that appears in the editor that allows her to edit or remove the image. She selects edit and it opens up the Media Browser to the Images tab. She changes the alignment and closes the dialog box.

- Like Google Sites but without the alignment options. See screenshot.
- If the panel is not feasible, then show a drop down toolbar (like we have in the editor when you select a table) that shows you an Edit Image button.

Kate is preparing a bio page. She wants to link to an image of her cat that she has on her personal website. She opens the Insert Image dialog box and clicks the Web Address tab. She puts in the URL and clicks Insert.

- Kate can align and put a border around web images.

Kate wants to change the source of a Web Image. She selects the image and sees a panel that appears in the editor. She selects edit and it opens up the Media Browser to the Web Images tab. She changes the URL of the Web Image and closes the dialog box.

Kate is preparing a bio page. She wants to link to an image of her cat that she has on her personal website. She opens the Insert Image dialog box and clicks the Web Address tab. She puts in the URL and clicks Insert.

Kate can align and put a border around web images.

Kate wants to change the source of a Web Image. She selects the image and sees a panel that appears in the editor. She selects edit and it opens up the Media Browser to the Web Images tab. She changes the URL of the Web Image and closes the dialog box.

Kate is preparing a bio page. She wants to link to an image of her cat that she has on her personal website. She opens the Insert Image dialog box and clicks the Web Address tab. She puts in the URL and clicks Insert.

Kate can align and put a border around web images.

Kate wants to change the source of a Web Image. She selects the image and sees a panel that appears in the editor. She selects edit and it opens up the Media Browser to the Web Images tab. She changes the URL of the Web Image and closes the dialog box.

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Insert Menu Spec

Goal
The amount of rich objects (embedded videos, office documents, images, links) that can be added to Confluence has grown rapidly over the last two releases. The insert menu is a drop down that gives users one simple place to go to add an object to a wiki page without clutter and confusion.

Mockup

Requirements

Insert Menu
<table>
<thead>
<tr>
<th>#</th>
<th>Requirement</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Option to insert image. This should open the Image Browser at the tab allowing file upload.</td>
<td>The most common attachment case is from your local machine. See the Media Browser spec for details on the Office Connector integration.</td>
</tr>
<tr>
<td>20</td>
<td>Option insert web image. This should open the Image Browser at the tab allowing URL.</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Option to insert an ‘Office’ document. This should open the Document browser at the tab allowing upload.</td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Option to insert a link. This should open the Link Browser</td>
<td>Inserting a 'generic' attachment i.e. one that is not an image or document can only sensibly be handled as an insertion of a link to an attachment.</td>
</tr>
<tr>
<td>45</td>
<td>Option to insert an attachment. This should open the Link Browser at the attachments tab.</td>
<td>This also follows the thought process a user would have in wanting to use these facilities. It also helps simplify the toolbar by moving less frequently used buttons into the menu.</td>
</tr>
<tr>
<td>50</td>
<td>Insert Emoticon, Symbol and Horizontal Ruler should be moved to the insert menu</td>
<td>This also follows the thought process a user would have in wanting to use these facilities. It also helps simplify the toolbar by moving less frequently used buttons into the menu.</td>
</tr>
<tr>
<td>60</td>
<td>Shortcut to the relevant Macro Browser screen for 5 installed macros</td>
<td>The macro browser can still be fairly daunting if you don’t know enough about the thing you are trying to insert. This is a good mechanism to introduce users to macros.</td>
</tr>
<tr>
<td>70</td>
<td>Option to launch the macro browser with no preselected macro.</td>
<td>If the macro required is not one of the 5 shortcut ones then the user needs a way to use the Macro Browser to find and configure an arbitrary macro.</td>
</tr>
</tbody>
</table>

Optional: Option to insert an attachment. This should open the Link Browser at the attachments tab. Inserting a 'generic' attachment i.e. one that is not an image or document can only sensibly be handled as an insertion of a link to an attachment. This also follows the thought process a user would have in wanting to use these facilities. It also helps simplify the toolbar by moving less frequently used buttons into the menu. The macro browser can still be fairly daunting if you don’t know enough about the thing you are trying to insert. This is a good mechanism to introduce users to macros. If the macro required is not one of the 5 shortcut ones then the user needs a way to use the Macro Browser to find and configure an arbitrary macro.

Optional: Option to launch the macro browser with no preselected macro. If the macro required is not one of the 5 shortcut ones then the user needs a way to use the Macro Browser to find and configure an arbitrary macro.

### Estimation

<table>
<thead>
<tr>
<th>Requirement Reference</th>
<th>Task</th>
<th>Estimate</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>New plugin websection in the menu</td>
<td>0.5d</td>
<td>The &quot;Document Browser&quot; from the Office Connector will present itself here.</td>
</tr>
<tr>
<td>10,20,30,40,45,50,60,70</td>
<td>Launching the appropriate dialogs at the appropriate tabs</td>
<td>2d</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Context sensitive Edit button in RTE</td>
<td>2d</td>
<td></td>
</tr>
<tr>
<td>120</td>
<td>Insert when already selected a previously inserted item</td>
<td>2d</td>
<td></td>
</tr>
<tr>
<td>200, 230</td>
<td>Configurable Macros presented in insert menu</td>
<td>1d</td>
<td>Includes the infrastructure work to store this configuration.</td>
</tr>
<tr>
<td>210</td>
<td>Simple admin configuration screen</td>
<td>0.5d</td>
<td>Admin just builds a list of macros by name.</td>
</tr>
<tr>
<td>Optional</td>
<td>Admin configuration screen with assistance</td>
<td>1.5d</td>
<td>Includes assistance/auto-complete for admin selecting macros.</td>
</tr>
<tr>
<td>80</td>
<td>Insert Menu for wiki editor</td>
<td>2d</td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>Context sensitive Edit button in wiki editor</td>
<td>2d</td>
<td>Matt Ryall has done a lot of work in this area and will be able to provide a better estimate when he returns.</td>
</tr>
<tr>
<td>130</td>
<td>Bug fixing the current edit buttons in wiki editor which do not pick up context.</td>
<td>2d</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Edit option on the context menu in RTE</td>
<td>2d</td>
<td></td>
</tr>
</tbody>
</table>
Totals

Complete Estimate: **18d**

Excluding Optional Work: **8.5d**

[ Requirements ] [ Insert Menu ] [ Estimation ] [ Totals ]

---

**Warning: Sample Content**

This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

---

**Quick Navigation Spec**

Writing a product specification requires input and feedback from many different people. With Confluence, product managers, engineers and technical writers can make their changes or comments directly in the product specification page. With version control, users can always see who contributed to the page and undo any edits regardless of when they were made. To get the most from this page, we suggest you:

1. Comment on this page to let your team members know what you think about the Quick Navigation product specification.
2. Edit this page and save your change. Then revert back to the previous version. Go into the "tools" menu and choose history. Then choose restore this version on a previous version of the page.

---

**Goal**

User can quickly and simply navigate to a page, person, space, or attachment via title.

**Use Cases**

**User**

1. Sees results in a panel below Quicksearch as they start typing. Sees instantaneous results. Selects a result to go to that page.
2. Can use keyboard to select results.
3. Sees results are in categories. 5 results max shown for pages and news together, 2 results for attachments, 3 results for people, and 2 results for space in that order.
4. Titles that are too long, are truncated.
5. Sees page and news results icon, and title only. For person, profile picture and name. For space, icon and name. No descriptions shown for anything.
6. Uses a link down the bottom linking to a full search so that keyboard users can execute search: 'Search All' with icon.
7. Sees part of the title that is matched by the search term in bold.
8. Appear in the page search in the Add Links

**Questions**

1. See the initial design meeting minutes and second meeting.
2. Pages and news mixed in together as one category? Why separate them? How would we do a combined 'News and Page' more search?
3. Multiple word searches (e.g. 'meeting min_') results aren't ordered (i.e. results can be 'minimum meetings', 'meeting minutes', 'meeting room minutes').
Example Human Resources Page

Your Human Resources team can use Confluence for presenting important HR-related documents and processes.

- Click through the slideshow below to see how the HR team presents the company mission.
- Click into each of the links below to see more.
- Watch these two short videos to see how the Talent Team at Atlassian use Confluence.

Human Resources Space

You need flash player installed to preview ppt and pdf files

Quick Links

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Induction</td>
<td>New Employee Checklist</td>
</tr>
<tr>
<td>Policies &amp; Procedures</td>
<td>Paid Time Off, Tax Forms, Travel</td>
</tr>
<tr>
<td>Recruitment Process</td>
<td>Listing of current open positions, job descriptions, etc.</td>
</tr>
<tr>
<td>Buddy System</td>
<td>Find your buddy here!</td>
</tr>
<tr>
<td>Birthday List</td>
<td>Staff birthday list</td>
</tr>
</tbody>
</table>
Company Induction

The Human Resources team uses tasklists to assign and prioritise simple tasks for new employees.

- Add a new task to this list
- Change the priority of one of the existing tasks.

Welcome, we’re glad to have you here 😊. To help you get started, we’ve created this simple task list of things you should accomplish in your first week. Feel free to contact anyone in HR or your buddy with any question you might have.

<table>
<thead>
<tr>
<th>New Employee Task List</th>
</tr>
</thead>
</table>
| Add your birthday to the birthday calendar
| Browse the Human Resources Space and read through policies

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.
Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

HR Policies and Procedures

Human resources uses attachments to share important tax forms and templates with employees.

- Click the view link on one of the attachments below to view its contents.
- Upload a new attachment to the page. From the Tools dropdown select Attachments and then upload your file to the attachments page.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>IRS_W9_Form.pdf</td>
<td>139 kB</td>
<td>Bill Arconati</td>
<td>Oct 18, 2008 09:31</td>
<td>All contract employees must complete this form.</td>
</tr>
<tr>
<td>Expense Report Template.xls</td>
<td>33 kB</td>
<td>Bill Arconati</td>
<td>Oct 18, 2008 09:31</td>
<td>Use this for submitting expenses.</td>
</tr>
<tr>
<td>Employee Handbook.doc</td>
<td>39 kB</td>
<td>Bill Arconati</td>
<td>Oct 23, 2008 06:00</td>
<td>Everyone must read and sign this</td>
</tr>
<tr>
<td>Daily Time Sheet.pdf</td>
<td>37 kB</td>
<td>Bill Arconati</td>
<td>Oct 23, 2008 06:03</td>
<td>For hourly employees to complete on a weekly basis</td>
</tr>
</tbody>
</table>

File uploaded successfully
Recruitment

Images and charts can sometimes communicate complex concepts better than text. For example, your HR team might use images to explain the company recruiting processes.

- Add a comment to this page to let people what you think of the recruiting process.

This page is designed for all employees involved in recruiting, selecting or inducting new high quality people. It integrates best practice elements from several sources to help us continue to grow, globally!

The Recruiting Process

1. Request New Staff
2. Approval
3. HR commences job advertisement
4. Pre-screening candidates
5. Initial application review by talent
6. Assign screened candidates to interviewers

The Selection Process

1. Application review by hiring team
2. Phone interview
3. Work history check
4. F2F Interview(s): technical skills and competencies
5. Reference checks
6. Offer
Buddy System

Use the rich text editor to author and format documents like this overview of the Buddy System. Once the document is complete and ready to publish, simply export the document to PDF for presentation as an ‘official’ document.

- Export this page to PDF from the Tools menu and save it to your hard drive.

Most new employees begin their first day of work full of excitement and enthusiasm. Depending on first impressions, this initial enthusiasm for the organisation can be either extended and nurtured or destroyed. Everything that happens in the first few days will affect the new hire’s perception of the organisation and the colleagues he or she will be working with.

**Why the Buddy System**

A buddy system builds a personal connection between the organisation and the new employee from the first day. The new employee is made to feel part of the organisation, gains more confidence and, as a result, becomes productive more quickly. We encourage new employees to have a buddy who is outside of their own department to ensure that new employees have an understanding of what other employees do and get to know other colleagues outside of their own work group. Here’s what some employees have to say about the buddy system:

- I’m usually shy about meeting new people. The buddy system got me talking to people I otherwise probably wouldn’t meet.
- After working here three years, I still go to lunch with my buddy at least once a month!
- My buddy made my first days at the company a lot less confusing and a lot more enjoyable.

**Who is a Buddy?**

At a minimum, the buddy should:

1. Take new employees to lunch in their first few days of employment
2. Provide an opportunity for new employees to ask questions without feeling intimidated
3. Ensure open lines of communication with new employees while respecting confidentiality
4. Offer encouragement
5. Check with the new employee every so often to answer questions and offer support (particularly in the first month of the new employee starting)
A Buddy is Not...

The buddy system does not replace the supervisor's responsibilities regarding department orientation or on-the-job training. It is not the responsibility of the buddy to train the new employee. The buddy should direct the new employee to the supervisor if the questions become more complex or involve the work itself. Also, the buddy is not responsible for the new employee's performance. The buddy is only there to help the new employee become socialised to the organisation.

So how does it work?

I have set up a wiki page for this buddy system, it will have the names of all current new employees and buddies. Prior to an employee commencing, I'll work with the hiring manager to choose a buddy and let you know if you are the buddy for our next new hire. So if your name is there, then you are the nominated one!

Company Birthday List

The table below is actually an Excel Spreadsheet that has been embedded in the page using the Office Connector. You can also embed PDFs, PowerPoint presentations and Word documents.

- Hover your mouse cursor above the top row of the table and click to edit the spreadsheet.

<table>
<thead>
<tr>
<th>January</th>
<th>February</th>
<th>March</th>
<th></th>
<th></th>
<th></th>
<th>October</th>
</tr>
</thead>
<tbody>
<tr>
<td>12th Rob Steiner</td>
<td>3rd Katherine Lee</td>
<td>No Birthdays</td>
<td>21st Quinn 23rd Howard Falstaff</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>17th Phil Burkis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Birthdays</td>
<td>5th Simon Jameson</td>
<td>26th Laura Keenan</td>
<td>21st Julie Osborne</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29th Marcus Halpern</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Have Fun
Confluence lets you easily embed content from popular user-generated sites like Youtube, Flickr, Slideshare, Google, Twitter and many other others.

- **Add a YouTube video to this page** by clicking the 'edit' button and pasting `{widget:url=http://www.youtube.com/watch?v=LIcv2V_Qwf8/}` at the bottom of the page.

We work hard to create useful products that people lust after, but we also know how to have fun. So what exactly is it like to work and have fun here?

*Life at Atlassian*

We've created a culture of openness and honesty, with no bullshit and no bureaucracy. Learn all about our values in the video below:

*San Francisco Holiday Party - December 2007*

The San Francisco crew chose for their holiday event a night of great food and jazz at the newly opened Yoshi's on Fillmore in San Francisco.

**Warning: Sample Content**

This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

*How the Talent Team at Atlassian use Confluence*

Confluence lets you easily embed content from popular user-generated sites like Youtube, Flickr, Slideshare, Google, Twitter and many other others.

- **Add a YouTube video to this page** by clicking the 'edit' button and pasting `*[widget:url=http://www.youtube.com/watch?v=LIcv2V_Qwf8/]` at the bottom of the page.

*Managing HR Projects with Confluence*

*Effective Delivery of HR Initiatives with Confluence*

**Warning: Sample Content**

This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

*Request Leave Form*
Welcome

The Design Team space is a repository for visual aspects of the Atlassian brand. Catalogued within this space are all the tools and guidelines required to create new graphic designs for Atlassian.

Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

Atlassian Colours
If you have a company standard colour scheme that should be used in all of your public-facing resources, record them on the wiki so that others can find them for themselves and you can focus on completing your own work. Why not try:

- **Adding** a row to one of the tables below. Click **Edit** in the top-right of this page. In the Rich Text Editor, right-click in the last cell of one of the tables and select **Row > Insert Row After**.
  
  Make sure the 'Context Menu' icon in the toolbar is active (with a tick).
- **Create** a new table when editing the page by clicking on the **Insert Table** icon in the Rich Text Editor's toolbar.

### Colour Values

<table>
<thead>
<tr>
<th>Colour</th>
<th>Name</th>
<th>RGB</th>
<th>HEX</th>
<th>CMYK</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Atlassian Blue" /></td>
<td>Atlassian Blue</td>
<td>0-51-102</td>
<td>#003366</td>
<td>100-67-0-23</td>
</tr>
<tr>
<td><img src="image" alt="Atlassian Medium Blue" /></td>
<td>Atlassian Medium Blue</td>
<td>51-102-153</td>
<td>#336699</td>
<td>89-43-0-0</td>
</tr>
<tr>
<td><img src="image" alt="Atlassian Light Blue" /></td>
<td>Atlassian Light Blue</td>
<td>102-153-204</td>
<td>#6699CC</td>
<td>55-19-0-0</td>
</tr>
<tr>
<td><img src="image" alt="Atlassian Black" /></td>
<td>Atlassian Black</td>
<td>0-0-0</td>
<td>#000000</td>
<td>50-33-0-100</td>
</tr>
<tr>
<td><img src="image" alt="Dark Grey" /></td>
<td>Dark Grey</td>
<td>102-102-102</td>
<td>#666666</td>
<td>0-0-0-75</td>
</tr>
<tr>
<td><img src="image" alt="Medium Grey" /></td>
<td>Medium Grey</td>
<td>153-153-153</td>
<td>#999999</td>
<td>0-0-0-50</td>
</tr>
<tr>
<td><img src="image" alt="Light Grey" /></td>
<td>Light Grey</td>
<td>204-204-204</td>
<td>#CCCCCC</td>
<td>0-0-0-25</td>
</tr>
<tr>
<td><img src="image" alt="White" /></td>
<td>White</td>
<td>255-255-255</td>
<td>#FFFFFF</td>
<td>0-0-0-0</td>
</tr>
</tbody>
</table>

### Product Colour Values

<table>
<thead>
<tr>
<th>Colour</th>
<th>Name</th>
<th>RGB</th>
<th>HEX</th>
<th>CMYK</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Crucible" /></td>
<td>Crucible</td>
<td>241-107-68</td>
<td>#F16B44</td>
<td>0-72-78-05</td>
</tr>
<tr>
<td><img src="image" alt="JIRA" /></td>
<td>JIRA</td>
<td>248-157-50</td>
<td>#F89D32</td>
<td>0-45-90-0</td>
</tr>
<tr>
<td><img src="image" alt="Bamboo" /></td>
<td>Bamboo</td>
<td>255-200-71</td>
<td>#FFC847</td>
<td>0-22-82-0</td>
</tr>
<tr>
<td><img src="image" alt="Confluence" /></td>
<td>Confluence</td>
<td>131-196-93</td>
<td>#83C45D</td>
<td>0-52-84-0</td>
</tr>
</tbody>
</table>
Atlassian Cotton

Confluence is a great tool for sharing images with your staff, customers or anyone on the internet. Below is a gallery of all the Atlassian Shirts that the Design Team have created. You could use Confluence to share pictures from a company event, mockups of interfaces for new features or even screenshots of your product for use in documentation. Why not try:

- Clicking on one of the shirts below to view the full-size image.
- Attaching other images to this page to preview them in the gallery below. Just go to the Add menu in the top-right of the page and select Attachments. Upload your your image and click on View in the top right of the screen to return to the page.
Atlassian Logos

Rather than being hassled by employees looking for Atlassian's product logos, the Design Team have made them available by attaching them to a Confluence page. Users are able to preview the logos in their full size in an elegant slideshow and download the latest version of the logo for use in their own presentations and documents. Why not try:

- Attaching your own image to this page so that it shows up in the gallery and list of images below. Go to Tools in the top-right of the screen and select Attachments. Upload your own image and click on View in the top-right of the Attachments screen to return to the page.

### Preview Logos

![Atlassian Logos Preview](image)

### Download Logos

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SystemAdministration.png</td>
<td>6 kB</td>
<td>Matt Hodges</td>
<td>Nov 19, 2009 13:43</td>
<td></td>
</tr>
<tr>
<td>DeveloperNetwork.png</td>
<td>29 kB</td>
<td>Matt Hodges</td>
<td>Nov 19, 2009 13:43</td>
<td></td>
</tr>
<tr>
<td>CustomerAdvocates.png</td>
<td>7 kB</td>
<td>Matt Hodges</td>
<td>Nov 19, 2009 13:43</td>
<td></td>
</tr>
<tr>
<td>CrossProduct.png</td>
<td>7 kB</td>
<td>Matt Hodges</td>
<td>Nov 19, 2009 13:43</td>
<td></td>
</tr>
<tr>
<td>confluence_maintenance.png</td>
<td>4 kB</td>
<td>Matt Hodges</td>
<td>Nov 19, 2009 13:43</td>
<td></td>
</tr>
<tr>
<td>CloverQuiver.png</td>
<td>7 kB</td>
<td>Matt Hodges</td>
<td>Nov 19, 2009 13:43</td>
<td></td>
</tr>
</tbody>
</table>
Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.

PowerPoint Templates

The Design Team uses Confluence to make company standard templates available to employees. Rather than storing these files on a network shared drive, they have instead attached them to a Confluence page so that they are accessible to everyone who has the permission to view the page. Gone are the days of trying to find files on a shared drive. Confluence makes your files easily accessible, secure and searchable. Why not try:

- **Searching for** *Happy Users* using the search box in the top right of the screen. As Confluence has indexed the full content of the PowerPoint Presentation you will see the file in your search results which you can quickly preview by clicking **View**. (View Video Tutorial)
- **Attach** your own PowerPoint, Word, Excel or PDF document and **embed** it in the page using the View File Macro. (View Video Tutorial)

Background Images

Content Slide

Download

Title Slide
Warning: Sample Content
This is sample content that comes included with Confluence for the purposes of demonstrating how the product can be used.